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1.  What is PMOP? 
 
Panda Managed Office Protection (PMOP) is a complete security solution to protect 
your computer network and manage security online with none of the hassle. Its 
protection neutralizes spyware, Trojans, viruses  and any other threats. 
The administration center of PMOP is the Clients’ Web Console (referred to in this 
guide as the Web console), from where you can configure the protection and 
distribute and install it on the computers you want to protect. It also lets you check 
the status of the protection and see any detections that have been made. 
 
You can also configure the quarantine used to store suspicious items, and decide 
how such items will be handled. PMOP also lets you generate reports on your 
security status, and export them in the format you want. 
 
Once you have established your computers' protection needs, you will be able to 
create profiles and configure the protection's behavior (antivirus and/or firewall) 
for the profiles that you have created. Then, you can assign that profile to the 
computers or computer groups to protect.  
 
You can configure the protection installed on computers either before or after 
installation, but it is advisable to spend some time considering the following points:  
 
- What are your specific protection needs?  
- How many computers do you want to protect? 
- What criteria will you use to group the computers to protect ? 
- What is the topology of your network? 
- Do you need to protect mobile users? 
- What types of users interact with your network? 
- What permissions do you want to give them? 
- Who will be in charge of administering security? 
  
These needs might vary from one computer to another, or be the same for all 
computers on the network. Depending on these circumstances you might need to 
create new profiles or use the PMOP default settings. 
 
Before installing the protection, check the Recommendations prior to 
installation. You will find important information about the installation and 
uninstallation processes, how to configure the protection language, and how to use 
the quick installation and default installation options. 
 
The configuration and installation processes are totally under your control; you will 
decide at all times which computers to protect, with which protection and the 
installation method. Once you have selected the computers to protect and the  
 
 
 
configuration profiles, you must distribute and install the protection. To help you we 
have prepared some simple instructions on installation modes and cases.   
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1.1 Who should read this guide? 
This Advanced Administration Guide is aimed at network administrators who want 
to keep their networks free from viruses and other threats.  
 
The information contained in this guide will allow you to configure, deploy and 
install the PMOP protection. To this end, in addition to a basic description of the 
possibilities that PMOP has to offer, you will find a series of configuration and 
installation examples which should prove useful when resolving any queries or 
problems. 
 
PMOP provides an optimum, integrated security service for your IT resources 
thanks to the efforts and experience that Panda Security invests in all its products.  
 

1.2 Contact Panda 
If you want to contact Panda, go to the following address: 
http://www.pandasecurity.com/about/contact/  
 
Select your country from the drop-down list to find the contact details of your local 
Panda office. This will allow you to contact Panda Security’s technical and customer 
services.  
 

1.3 System requirements 

1.3.1 Requirements for using the Web console 
 
Browser: 
- Internet Explorer 6.0 or later 
- Mozilla Firefox 2.0 or later 
 

 To prevent any errors with the security certificate in this browser, Use SSL 3.0  and Use TLS 1.0 must 
be enabled.  You can enable these options through Tools> Options> Advanced> Encryption. 

Network: 
- Internet connection: direct or through a local area network. 
- HTTP connection (port 443). 
 

1.3.2 Requirements for the computer from which the protection is 
deployed 

 
Operating system:  
Windows Vista (32 and 64-bit), Windows XP Professional (32 and 64-bit), Windows 
2000 Professional, Windows Server 2000, Windows Server 2003 (32 and 64-bit), 
Windows Server 2008 (32 and 64-bit). 
 
Memory:  
64 MB  
 
Hard disk:  
20 MB  

http://www.pandasecurity.com/about/contact/�
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Processor:  
- Pentium 300 MHz or equivalent. 
- Windows Installer 2.0  
 
Browser:  
- Internet Explorer 6.0 or later 
 
- Access to the Admin$ resource on the computers to which the protection will be 
distributed. 
 
- A user with administrator rights to the computers to which the protection is 
distributed. 
 

1.3.3 Minimum requirements for the computers to which the 
protection is distributed 

 
Processor:  
Pentium 300 MHz or equivalent. 
 
Hard disk:  
- Antivirus: 270 MB  
- Firewall: 180 MB  
- Antivirus + Firewall: 280 MB 
 
- Windows Installer 2.0 
 
- Disable the Windows firewall or configure the exception File and printer sharing 
(Start > Settings > Control panel > Network connections > Local area 
connections > (right button) Properties > General tab> Settings). 
 
- To have Use simple file sharing disabled (on Windows XP, Tools > Folder 
Options > View > Use simple file sharing). 
 
-On computers with Widows Vista and that are not within a domain with active 
directory, disable the UAC (Users Account Control): (Control panel > User 
accounts > Turn User Account Control On or Off > disable the checkbox 
'Use User Account Control (UAC) to help protect your computer). 
 

Workstations 

 
Operating systems:  
Windows XP (32 and 64-bit), Windows 2000 Professional, Windows Vista (32 and 
64-bit) 
 
RAM:  
For the antivirus protection: 64 MB, for the Firewall: 128 MB. 
 
Browser:  
Internet Explorer 6.0 or later 
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At least one of the servers or workstations must have an Internet connection. 
 
 

Servers 

 
Operating systems:  
Windows 2000 Server, Windows Server 2003 (32 and 64-bit), Windows Server 
2008 (32 and 64-bit) 
 
RAM:  
256 MB  
 
Browser:  
Internet Explorer 6.0 or later 
 
At least one of the servers or workstations must have an Internet connection. 
 

Accessible URL's  

 
To access the PMOP servers and be able to download updates, at least one of the 
protected computers must have access to a series of Web pages. These are: 
 

-To update the signature files and protection engine: 
 
http://enterprise.updates.pandasoftware.com/updates_ent/  
http://acs.pandasoftware.com/member/installers/ 
http://acs.pandasoftware.com/member/uninstallers/ 
http://acs.pandasoftware.com/member/pavsig/ 
http://acs.pandasoftware.com/free/ 

 

-To send suspect files to Panda: 
 
http://hercules.pandasoftware.com/getqesi.aspx 
http://hercules.pandasoftware.com/getqesd.aspx 
 

-For communication with the server: 
 
http://mp-agents.pandasecurity.com/Agents/Service.svc 
https://mp-agents.pandasecurity.com/AgentsSecure/Service.svc 
 
Ports (client intranet) TCP 18226 and UDP 21226 must be opened to allow correct 
communication between the PMOP agents. 
 
 

http://enterprise.updates.pandasoftware.com/updates_ent/�
http://acs.pandasoftware.com/member/installers/�
http://acs.pandasoftware.com/member/uninstallers/�
http://acs.pandasoftware.com/member/pavsig/�
http://acs.pandasoftware.com/free/�
http://hercules.pandasoftware.com/getqesi.aspx�
http://hercules.pandasoftware.com/getqesd.aspx�
http://mp-agents.pandasecurity.com/Agents/Service.svc?sitepanda=particulares�
https://mp-agents.pandasecurity.com/AgentsSecure/Service.svc?sitepanda=particulares�
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1.4 Services 

1.4.1 Tech support and protection services 
The administrator can easily access the services offered with the solution, as they 
will be integrated in the Web administration console. These services are: 
 
- 24h-365d Tech Support by telephone and email. 
- Daily updates. 
- Express updates in the event of epidemics. 
- Virus warnings and information (SOS Virus).  
- Software updates of the protection for workstations and improvements to the Web 
console. 
 

1.4.2 Services associated to the Hosted Service 
The architecture that hosts the PMOP service in Panda Security ensures the 
following: 
 
- Load balancing and high availability. 
- Fault tolerance 
- High performance 
- Scalability. 
 
 

 
 
The Panda Managed Office Protection Hosted Service backend architecture consists 
of a dedicated infrastructure that supports the service. The information in this 
infrastructure is completely protected to guarantee confidentiality. 
 
Communication security 
 
The information sent from the customers to the Panda Security Service travels 
securely via HTTPS and encrypted and compressed HTTP. 
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Customer dat in the Hosted Service 
 

EndPoint 
Information 

Events 
Information 
(General) 

Events 
Information 
(Malware) 

Events 
Information 
(Firewall) 

Events 
Information 
(Suspicious) 

Name 
Endpoint 
identifier 

Malware 
identifier 

destination IP  CRC or MD5  

IP address 
Protection 
Identifier  

Compressed 
File or not 

destination 
TCP Port/UDP  

File Name 

Dominio or 
Workgroup 

Protection 
module 
Identier  

Path  Source IP 
Type of 
element moved 
to quarentine 

MAC address 
Detection 
Date and hour 

File Name 
Source TCP 
Port/UDP 

Path 

OPerationg 
System and 
Service Pack 

Analysis type:  
Permanent; 
on-dommand 

  
Networh card 
MAC  

File size 

RAM Malware type   Protocol  
Compressed 
File or not 

Last signature 
file update date 

Action taken 
after detection 

    
Date and hour 
sent to Panda 
Labs 

Lat date of 
communication 
wit server 

Session user       

Protection status 
(enable, disable, 
with errors) 

Infected User       

 
 
Maintenance of data in the Hosted Service 
 
Type of Information Time 
Customer Information Licenses end date + 15 days + 40 days. 
Endpoints information 40 days since last day infomration is 

sent to server. Endpoints send 
information every day is they are on. 

Event information (malware or firewall) 7days 
Suspicious file information 30 days 
Statistic x hour 24 hours 
Statistic x day 31 days 
Statistic x month 12 months 
 
 
 
 

1.5 Key concepts 
 

Network adaptor 
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The network adapter allows communication between devices connected to each 
other and also allows resources to be shared between two or more computers. It 
has a unique identifier. 

Adware 
Program that automatically runs, displays or downloads advertising to the 
computer. 

Administration agent 
This is the agent responsible for communication between the administered 
computers and the PMOP servers, as well as managing local processes. 

Antivirus 
Programs designed to detect and eliminate viruses and other threats. 

Signature file 
This is the file that allows the antivirus to detect threats. It is also known simply as 
the signature file. 

Broadcast domain 
This is a logical division of a computer network, in which all nodes can reach each 
other by broadcast at the data link layer.  

Client’s Web console 
The Web console lets you configure, distribute and manage the protection across all 
network computers, as well as knowing the security status of the network and 
allowing you to generate and print reports. 

Quarantine 
Quarantine is the place where suspicious or non-disinfectable items are stored, as 
well as spyware and hacking tools detected. 

Dialer 
Program that redirects users that connect to the Internet using a modem to a 
premium-rate number, Premium-rate numbers are telephone numbers for which 
prices higher than normal are charged. 

IP address 
Number that identifies an interface in a network device that uses the IP protocol. 

MAC address 
Hexadecimal, 48-bit unique identifier of a network card or interface. It is individual; 
each device has its own MAC address. 

Firewall 
This is a barrier that can protect information in a system or network when there is a 
connection to another network, for example, the Internet. 

Peer to Peer (P2P)  
In the case of Panda, the P2P feature reduces use of bandwidth for the Internet 
connection, as computers that have already updated a file from the Internet then 
share the update with other connected computers. This prevents saturating 
Internet connections.  

Proxy function 
This feature allows PMOP to operate in computers without Internet access, 
accessing through an agent installed on a computer in the same subnet. 

Group 
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In PMOP, this is a set of computers to which the same protection settings profile is 
applied. There is an initial group or default group in PMOP to which the 
administrator can add all the computers to protect. New groups can also be 
created. 

Distribution tool 
Once downloaded from the Internet and installed on the administrator's PC, the 
distribution tool lets you remotely install and uninstall the protection on selected 
network computers. 

Hacking tool 
Programs that can be used by a hacker to carry out actions that cause problems for 
the user of the affected computer (allowing the hacker to control the computer, 
steal confidential information, scan communication ports, etc). 

Hoaxes 
These are spoof messages, normally emails, warning of viruses/threats which do 
not really exist. 

Joke 
These are not viruses, but tricks that aim to make users believe they have been 
infected by a virus. 

Blacklist 
This is a list of computers to which the protection will not be distributed. If a 
computer in the blacklist already has the protection installed, it will not be updated. 
Groups of expired computers and computers whose maximum number of 
installations allowed has been exceeded are also blacklisted. 

Malware 
This term is used to refer to all programs that contain malicious code (MALicious 
softWARE), whether it is a virus, Trojan, worm or any other threat to the security of 
IT systems. Malware tries to infiltrate or damage computers, often without users 
knowing, for a variety of reasons. 

Node 
In computer networks, each computer on the network is a node, and if talking 
about the Internet, each server also represents a node. 

Panda EndPoint Protection 
Name of the protection distributed and installed by PMOP on the computers on the 
network. 

Profile 
A profile is a specific protection configuration. Profiles are assigned to a group or 
groups and then applied to all computers that make up the group. 

Phishing 
A technique for obtaining confidential information fraudulently. The information 
targeted includes passwords, credit cards and bank account details. 

Local Process 
The local processes are responsible for performing the tasks necessary to 
implement and manage the protection on computers. 

Protocol 
System used for interconnection of computers. One of the most commonly-used is 
TCP-IP. 

Proxy 

http://www.pandasecurity.com/spain/homeusers/security-info/glossary/glossary.aspx#VIRUS�
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A proxy server acts as an intermediary between an internal network (an intranet, 
for example) and an external connection to the Internet. This allows a connection 
for receiving files from Web servers to be shared. 

Port 
Point through which a computer is accessed and information is exchanged 
(inbound/outbound) between the computer and external sources (via TCP/IP). 

Rootkits 
A program designed to hide objects such as processes, files or Windows registry 
entries (often including its own). This type of software is not malicious in itself, but 
is used by hackers to cover their tracks in previously compromised systems. There 
are types of malware that use rootkits to hide their presence on the system. 

SMTP server 
Server that uses SMTP -simple mail transfer protocol- to exchange email messages 
between computers. 

Spyware 
A program that is automatically installed with another, (usually without the user’s 
permission and even without the user realizing), and which collects personal data. 

Network topology 
The communication structure of nodes on a network. 

Trojans 
Programs that reach computers disguised as harmless programs that install 
themselves on computers and carry out actions that compromise user 
confidentiality. 

Public network 
This is the type of network you will find in cybercafes or airports, etc. Visibility of 
computers will be restricted on such networks, and there are restrictions on sharing 
files, resources and direct carries. 

Trusted network 
In this case we are generally talking about office or domestic networks. A computer 
will be perfectly visible to the other computers on the network. There are no 
limitations on sharing files, resources or directories. 

Environment variable 
This is a string containing information about the environment, such as the drive, 
path or filename, associated with a symbolic name that can use Windows. The 
System option in the control panel or the system symbol Set command can define 
environment variables. 

Virus 
Viruses are programs that can enter computers or IT systems in a number of ways, 
causing effects that range from simply annoying to highly-destructive and 
irreparable. 
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2. Configuration and installation examples 
 
This guide offers three installation and configuration examples, each referring to a 
specific type of company and network:  

2.1 Example 1 
SMB with a local network of 30 computers.  

2.2 Example 2 
Company with a centralized network:  
 
-minimum of 100 computers all in the same physical location. 
-multiple servers and domains. -mail and gateway servers.  

2.3 Example 3 
Company with decentralized network: 
  
- minimum 100 computers, distributed across several offices in several cities. In 
some locations the network will be slow. 
- multiple servers and domains.  
- mail and gateway servers.  
 
Configuration, deployment and installation of the protection on computers will be 
different in each case, according to the needs and characteristics of each company.  
 
In the section, Examples: configuration and installation recommendations 
you will find more details on these aspects. These cases will be used to illustrate 
the PMOP installation and configuration process. We hope this will be useful for 
resolving any queries that you have regarding installation and management of 
PMOP. 
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3. Configuring and installing the protection 

3.1 Configuring the protection 
The protection provided by PMOP is designed to be installed and distributed across 
your network. Therefore the protection to be installed will vary depending on the 
computers to protect and your specific security needs. 
 
You can configure the protection before or after installation. To do this, you have 
to create a profile and then assign it to a group or groups.  
 

In this guide the configuration process is explained as a step prior to installing the protection on the 
computers. 

When assigning profiles to the groups created, there are several options: one single 
profile applied to several groups, each group with a different profile, or just one 
profile and one group.  
 
When you create a profile you configure the way that the protection will operate for 
this specific profile, i.e, you determine which types of scan are carried out on which 
elements, how often the protection is updated and the action that will be taken 
when items are placed in quarantine. 
 

 
 

 If you do not need to create any profiles or groups in addition to those provided by PMOP by default, go 
to the Installation and settings menu and select the Default group. Then select the installation mode you 
want to use for installing the protection on your computers. 

Below we describe how to create and configure profiles prior to installing the 
protection on computers. 
 
Before starting to install the protection, you can create and configure the profiles 
you need. Then create groups of computers and assign profiles to the groups, so 
that each group will have a specific protection profile. 
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3.1.1 Default profile 
Select Profiles to go to the Installation program profiles window. This window 
displays existing profiles.  
 
The first time you go to this window you will see the Default profile and 
information about the associated protection.  
 
If at anytime you want to change the settings of this profile, click the name of the 
profile. This will take you to the Edit profile window. Make any changes you 
require and save them using the Save option. If later you want to restore the 
original settings of the profile, you can do so using the option Restore default 
settings in the Edit profile window. 
 

3.1.2 New profile 
If you need to create new profiles, they will be displayed alongside the default 
profile with information about the protection included. You can always edit the 
settings of a profile by clicking on its name and going to the Edit profile window as 
explained for the default profile. 
 
To create a new profile, click Create new profile, and go to the Edit profile 
window. From there you will be able to include settings in the new profile. 
 
There are three sections for creating and configuring a profile, located in the left-
hand column under the option Profiles. These sections are: General, Antivirus, 
and Firewall. Below we describe some of the settings options that you should bear 
in mind. 
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3.1.3 General settings 
 

 
 
In this section you can select general configuration options related to the profile, 
and it is therefore important to have a clear idea of the type of profile you want, 
largely depending on the computers that you want to protect with this profile. 

Main tab 
The options in this tab will allow you to name the profile you are creating and 
decide which protection you want to activate: antivirus, firewall, or both. 
 
You can also add an additional description to identify the profile and select the 
language in which you want the protection installed. By clicking Advanced 
settings you will go to the Edit profile – Advanced settings screen.  
 
If you want the protection to update automatically select the corresponding 
checkbox. If you click Advanced update settings, you will go to the Edit profiles 
– Advanced update settings screen. 
 
If you want suspicious items to be sent to Panda Security for analysis, select 
Enable automatic sending of suspicious items to Panda Security 
(recommended). To find out more about this service, move the cursor to   Find 
out more about sending suspicious items to Panda Security. 
 

Scheduled scans tab 
The options in this tab will let you configure scans to be launched from the Web 
console. Click New to go to the Edit profile – New scan job window.  
 
Firstly, choose a name for the scan job. Then choose the type of scan you want to 
create: immediate, scheduled or periodic.  
If when you create a profile you configure an immediate scan, this will take place as 
soon as you install the protection on the computers.  
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If you select a scheduled scan, you have to decide whether this includes all the PC 
or if it will only focus on hard disks or email. You will also have to indicate the time 
and date of the scan. 
 
In the case of periodic scans, in addition to the above you will also have to specify 
the frequency with which the scan takes place. This can be daily, weekly or 
monthly. 
 
As you create scan jobs, these will be added to the list of Scheduled scans, from 
which you can edit them or remove them if desired. 

 

Warnings tab 
Here you can configure warnings to be displayed when malware is detected on 
computers. You can also indicate whether these warnings will be local, by email or 
both. The difference is that local warnings are displayed on the computer or 
computers on which the detection occurs, while the email warnings are sent to the 
selected computers. To select them you will have to configure the accounts and 
specify the SMTP server to use.  
 

Apply to tab 
When you assign the profile to a group or groups, these will appear in this list. 
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3.1.4 Edit profiles - Advanced settings 
 

 
 
You can access this window by clicking on the Advanced settings link in the Main 
tab of the Edit profile window. 
 
Here you can configure aspects related to the installation of the protection on 
computers, as well as the connection of these computers to the Internet and to the 
PMOP servers. You can also configure options related to the suspicious file 
quarantine. 
 

Installation 
Specify in which directory you want to install the protection. By default, PMOP 
displays an installation path, but you can change this by using an environment 
variable other than %ProgramFiles%. 
 

Internet connection 
Specify the computer's Internet connection, if it uses a proxy, and if proxy 
authentication is required. 
 

Server connection options 
Establish how often you want the computer to send information to the PMOP 
servers about the status of the protection installed. You can change the frequency 
displayed by default, but it must be a value between 12 and 24 hours. 

 

Quarantine options 
Files in quarantine are analyzed to determine whether they represent a threat or 
not. Where they are not a threat, you can choose to restore them. Specify the path 
in which they should be restored. 
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Advanced update settings 

 

 
 
You can access this window by clicking on the Advanced update settings link in 
the Main tab of the Edit profile window. 
 
Here you can request automatic updates of the protection engine, and change the 
frequency at which the application checks for updates. By default, the frequency is 
every 12 hours. You can also select a time band for carrying out the update. Select 
the corresponding checkbox if you want computers to be restarted when the update 
process requires.  
 
 
It is important to keep the signature file updated, to ensure that the antivirus 
detects the new threats that appear every day. The option to update the signature 
file automatically is enabled by default, it is not advisable to disable it. You can 
modify the interval at which to check it there is an update available -by default the 
interval is 4 hours-. 
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3.1.5 Configuring the Antivirus protection 
 

 
 
This menu lets you configure the general behavior of the Antivirus permanent 
protection for the profile you are creating. There are four tabs: Files, Mail and 
messaging, Internet use, and Heuristic. 
 

Files tab 
Here you can configure the basic operation of the Antivirus  with respect to file 
protection. If you want more detailed settings, click Advanced settings. This will 
take you to the Advanced settings Antivirus – File Protection.  
 
Select Enable permanent file protection. Then select the corresponding 
checkbox if you want the protection to include compressed files and/or files on 
shared network drives. Select the types of malware that you want the protection to 
detect.  
 
 

 Detection of viruses will always be enabled while the file protection is enabled. 
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You can also configure the action you want the permanent protection to take on 
detecting malware: disinfect or delete the malware detected. If neither of these 
options is possible, the file will be moved to quarantine. 
 

Mail and messaging tab 
In this window you can configure how the antivirus protection will operate with the 
profile you are creating with respect to email and instant messaging. If you want 
more detailed settings, click Advanced settings. This will take you to the 
Advanced settings Antivirus – Mail and messaging protection screen.  
 
Indicate if you want to enable permanent email and messaging protection, as well 
as for compressed files. 
 
Select the the type of malware you want to detect. Use the corresponding 
checkbox. 
Decide if you want to disinfect or delete infected files. If neither of these options is 
possible, the file will be moved to quarantine. 
 

Internet use tab 
Here you can configure the basic operation of the Antivirus in each profile with 
respect to Internet use. 
 
Enable the permanent protection for Internet use. 
 
Use the checkbox to indicate if you want the protection to include compressed files. 
 
Decide the type of malware you want to detect. The malware will be disinfected 
automatically. If it cannot be disinfected it will be eliminated. 
 

Heuristic tab 
The genetic heuristic scan analyzes programs in depth, in audit to determine, using 
digital genetic traces and program behavior, if any type of malware is present. 
 
In this window you can choose in what circumstances you want the heuristic scan 
to be active (files, email and messaging, Internet use) and which action you want 
to take on detecting malware. 
 
In the first case, the item detected will be send to quarantine, while in the other 
two cases you can configure whether to delete it or send it to quarantine. 
Enable the corresponding checkbox, select the action you want and click OK. 
 

3.1.6 Local scans  
Panda Endpoint Protection is the name of the protection that PMOP deploys and 
installs on computers. Through the Windows right-click menu, or that of the 
protection, you can access the different scan options: 
 

Right-click scan of a selected item 
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Select a folder, drive, file or any other scannable item and right-click it. You will 
then see a Windows menu, giving you the option to Scan with Panda Endpoint 
Protection.  
 
The scan will be launched immediately. You can pause the scan and restart it later. 
When it is finished you will see the result of the scan and you will also be able to 
print, export or save the report 
 
 

Local ‘right-click’ scan from Panda Endpoint Protection  

 

 
 

The Panda Endpoint Protection pop-up menu can be accessed by right-clicking the application icon at 
the bottom right of the screen, (normally next to the system clock).  

Although you can pause, cancel or restart the scan, it is highly advisable to let it finish, to ensure that 
your PC is clean. 
 
From this menu you can scan all of your PC and your email. There are several types 
of scan: 
 

Quick scan 
Select the option Quick scan from the menu. The scan will start immediately, 
examining running processes and all loaded libraries, along with the registry keys 
often used by malware and cookies. This will determine if the PC is infected with 
active malware at the moment the scan is run. This scan only lasts a few seconds 
and does place an excessive load on the computer. 
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Full scan 
Select Full scan from the pop-up menu. The scan will examine all of your PC to 
ensure it is free from threats. The duration of the scan will depend on the speed of 
your computer and the amount of data stored.  
 

Mail scan 
Select Mail scan from the pop-up menu. All messages in all your mailboxes will be 
scanned.  
 

 This type of scan is supports Outlook Express, Windows Mail and Microsoft Outlook.  

 

Scanning other parts of your computer 
Select Scan other parts of your computer. 
 
In the Other parts of your computer window, select the folders or files you want 
to scan (this could be more than one). Select the corresponding checkboxes and 
click OK . 

Scan summary 

 

 
 
Once the scan has finished you will see a detailed summary, which will include 
information about files moved to quarantine, if applicable. 
If you want you can print the scan report or save it in txt format.  
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3.1.7 Advanced settings – Antivirus 
 

File Protection 

 

 
 
This screen lets you configure detailed antivirus protection options for a profile, 
with respect to the file protection. You can do this based on general criteria for all 
types of files or applying only to those with a certain extension. Similarly, you can 
also select certain file extensions to exclude. 
 
The window is divided into two sections: Extensions to scan and Exclusions. 
 

Extensions to scan 
Select Scan files with any extension or Only scan files with the specified 
extensions. To do this, enter the extension in the text box (don't forget the initial 
dot) and click Add. You can delete, clean or restore the list of extensions using the 
corresponding buttons. 
 
In both cases, you can also add files without extensions to the scan, or all Office 
documents. Use the corresponding checkboxes. 
 

Exclusions 
In the Type menu, select the exclusion you want to establish: Directory, File or 
Extension. 
 
In the Value text box, enter the name of the file, extension or directory. 
 
Click Add. 
 
Click Delete to remove items from the list. 
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Mail and instant messaging protection 

 

 
 
To ensure an optimum level of protection on your computers, it is essential to 
protect them from threats that can reach systems through email and instant 
messaging.  
PMOP lets you configure the antivirus protection for email and messaging for each 
profile. You can do this generally, for all files received, or according to extensions. 
 
Select Scan files with any extension or Only scan files with the specified 
extensions. Enter the extension in the text box and click Add.  
 
You can delete, clean or restore the list of extensions using the corresponding 
buttons. 
 
In both cases, you can also add files without extensions to the scan, or all Office 
documents. Use the corresponding checkboxes. 
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3.1.8 Configuring the Firewall protection 
 

 
 

Central administration (from the client Web console) 
Here you can start to configure the firewall protection for the profile you have 
created. 
 
Firstly, you must decide if the users to which the profile will be applied will be 
allowed to configure the firewall from their computers. If so, select Allow 
configuration of the firewall by the client. In this case, consult the section on 
Administration from the client ( Endpoint icon). 
 
If on the other hand, you want the configuration to be available only from the Web 
console, you, as the administrator, will establish the restrictions, blocking, 
permissions, etc. If you choose to configure the firewall from the Web console, keep 
the default option to Apply the following firewall settings and continue 
configuring through the General, Programs, Intrusions, and System tabs. 
 

General tab 
Select Enable Firewall. 
 
Select the type of network to which you want to connect. The configuration will be 
more restrictive in the case of a public location and more flexible if it is a trusted 
location. 
 
Click OK. 
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Programs tab 
Enable the Panda Security rules. These are rules that have been established by 
Panda for the most common applications and helpful for administrators when 
configuring the protection. They can be edited, but not deleted. 
 
Add programs and assign communication permissions. To do this, click Add.  
Permissions can be: 
 
Allow inbound and outbound 
The program can connect to the Internet and the local network and allows other 
programs or users to connect to it. There are certain types of programs that need 
these permissions to work correctly: file sharing programs, chat applications, 
Internet browsers, etc. 
 
Allow outbound: 
The program can connect to the network, but does not accept external connections 
from other users or applications. 
 
Allow inbound   
The program accepts connections from programs or users from the Internet, but it 
will not have outbound permissions to connect. 
 
Don't allow any connection 
The program cannot connect to the network. 
 
You can edit or eliminate the programs added through the Settings and Delete 
buttons. 
 
Decide if you want to allow or deny communications of programs for which no rule 
is determined. Use the Default action list. 
 
 

Intrusions tab 
Here you can configure the basic operation of the firewall in each profile with 
respect to IDS attacks and network viruses. 
 

IDS attacks 

The Intrusion Detection System is a program used to detect unauthorized access to 
a PC or a network. 
 
It is based on detailed analysis of network traffic, comparing it against identifiers of 
known attacks or suspicious behavior, such as port scanning, malformed packets, 
etc.  
 
The IDS doesn't just analyze the type of traffic, it also checks content and behavior. 
PMOP lets you select the option to detect IDS attacks. IDS intelligence combined 
with the firewall results in a powerful tool for blocking threats before they can 
penetrate the network. 

Network viruses 



 
 
 

 
© Panda Security 2008     

29 

These are viruses that spread across internal networks and the Internet, using 
shared resources such as network drives and folders, etc. 
 
Select the corresponding checkboxes and click OK. 
 
 

System tab 
The system rules let you establish connection rules that affect the whole system, 
and have priority over those rules configured previously for the connection of 
programs to the network. 
 
The order of the rules in the list is not random. They are applied in descending 
order, and so if you change the position of a rule, you will also change its priority. 
 
In the New system rule window, you can select the action that you want to deny 
or allow, choose the communication direction, and the network. You can also 
determine the protocol, the port  and the PCs to which the rule applies, specifying 
the IP address, the  MAC address  or both. 
 
Enable the Panda Security rules. Add rules and grant communication permissions; 
select protocols and PC's to which the rules will apply. Use the Add button. 
 
You can edit or eliminate the the rules and permissions through the Settings and 
Delete buttons. 
 

 When you have completed the General, Antivirus and Firewall configuration for the new profile, you can 
check that it has been generated correctly in Installation program profiles. 

 

Administration from the client (Endpoint icon) 

 

 
 
The Panda Endpoint Protection can access the firewall settings provided this has 
been authorized by the PMOP administrator, as explained in the section 
Centralized administration (from the client Web console) 
 
The user can configure the firewall not just to filter inbound and outbound 
connections when the computer connects to the Internet, it also monitors 
connections between the computer and other network computers with which the 
user can share files, folders, printers and other resources. 
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Any time a program tries to connect to the Internet from the user's computer 
(outbound connections), or there is an attempt from the Internet to connect to the 
user's computer (inbound connections), PMOP will ask for permission to authorize 
the connection. It does this through pop-up messages that let the user authorize or 
deny connections and configure other related aspects.  
 
If the user wants to permanently allow or deny the connection in question, they can 
select the corresponding option in the pop-up message. 
 

In the case of outbound messages, if automatic assignment of permissions is enabled, PMOP will not 
ask to authorize the connections and will do it automatically. 

By doing this, as users assign permissions and configure the settings, they will gain 
total control of the connections established to and from the computer. 
 
The settings can be accessed by right-clicking the Panda Endpoint Protection icon, 
which is normally next to the system clock in the bottom right corner of the screen. 
Next, select the option Firewall settings, and a window appears with the following 
tabs: 
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To add a rule, click Add. 
 
In the Add new rule window, you can select the action that you want to deny or 
allow, choose the communication direction, and the network. You can also 
determine the protocol, the port and the PCs to which the rule applies, specifying 
the IP address, the MAC address or both. 
 
Click OK to go back to the System window. Check that the rule you have created 
appears correctly in the list. 
 

2.  Modifying a rule 

If you want to change any system rules, select it and click Settings. Make the 
corresponding changes in the System rule settings window. 
Click OK to go back to the System window. 
 

3.  Deleting and/or restoring a rule 

Once back in the System window you can delete any rules by clicking Delete.  
 
4.  If you want to restore a rule to its original status, click Restore and accept 
the confirmation message. 
 

 The Restore option not only restores the rules for deleted programs, but also restores the default 
settings for the program. However, programs without predefined rules will be removed from the list. 

Click Apply and OK to close the System window and save the changes. 
 
This concludes the General configuration of the Antivirus and Firewall protection 
for the new profile. You can now check whether the profile appears correctly in the 
Installation program profiles. 
 

3.2 Recommendations prior to installing the 
protection 

3.2.1 Computer requirements 
Regardless of the installation method to use, it is advisable to check the 
requirements  to be met by the computers the protection is to be installed on. 

3.2.2 Presence of other protection software on computers 
It is very important that before installing PMOP on computers, you make sure that 
no other antivirus or security solution is installed. Most of these –see list - will be 
detected and uninstalled automatically by the PMOP installer. If yours is not on the 
list, uninstall it manually (Control panel > Add or remove programs) before 
installing PMOP.  

3.2.3 Computers with Panda AdminSecure installed 
Before distributing PMOP on a network where Panda AdminSecure is deployed, bear 
in mind whether the Automatic installation option is enabled in Panda 
AdminSecure. If it is enabled, once PMOP is installed, the Panda AdminSecure agent 
will try to uninstall it and install its own protection. For more information, refer to 
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antivirus or security solution is installed. To do this, check the Recommendations 
prior to installation. 
 

  In the case of computers with an AdminSecure version prior to 4.02 SP2, you must disable the 
Automatic installation option in the Automatic installation settings AdminSecure screen, or select the 
computers from which AdminSecure will be uninstalled. Then you can install PMOP. 

 In most cases, when installing the new protection and uninstalling the previous protection, you will need 
to restart the computer once (twice at most). 

 

3.4.3 Automatically uninstalling other protections  
Most other security solutions are detected by PMOP when starting the installation 
process and uninstalled automatically. If you want to see the up-to-date list of the 
protection that is uninstalled, you can do so here. 
 

3.5 Creating a group 
PMOP lets you group a series of computers and apply the same protection profile to 
the whole group. 
 
Click Installation and settings > Group, to open the main Groups window. As 
you create groups and associate them to profiles, the groups will appear here, with 
their name and profile. 
 
The information is divided into four columns: Name, Profile, Max. number of 
installations, and Expiry date. The last two will only be available if you have 
selected the Assign restrictions to groups option in the Preferences window. 
 

 By default the application shows the Default group and profile. None of these can be deleted. 

Click Create new group to access the Edit group window. 
  
Enter the name of the group in the corresponding text box. 
 
In the Profile menu, select the profile to assign to the group. 
 

 If you selected the Assign restrictions to groups option in the Preferences window, you will be able 
to select the expiry date and the maximum number of installations for the group, by using the 
corresponding checkboxes. 

Once you have assigned the name and the profile, you can select the computers to 
belong to the group from Available computers. To do this: 
 
Select the computers and click Assign. 
 
Click the Computers in group tab, and check that the computers have been 
correctly assigned to the group.  
 
If you want to move any computer from one group to another, select it and choose 
the group in the Move selected computers to the group drop-down menu. Then 
click Move. 
 

http://www.pandasecurity.com/enterprise/support/card?id=50021&idIdioma=2�
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Click OK and the application will display the main Groups window. The group you 
have just created will appear with its name and profile on the list. 
 
If you want to remove any group, select the checkbox of the group you want to 
remove and click Delete. 
 

 Remember that if you eliminate any group all corresponding data will be lost. 

 

3.6 Deploying the protection 
Before going into detail on the files, registry keys and folders created on deploying 
the protection in computers, we offer information about the administration agent 
the P2P function, the proxy function and protection installation times. All these 
factors are important to have more in-depth knowledge of the deployment process. 
 

3.6.1 The administration agent 
The agent is responsible for communication between the administered computers 
and the PMOP servers. Effectively, it ‘talks’ with the agents in the computers in the 
same group and is responsible for downloading installation programs from the 
Internet. 
 
When the agent installer is run, the PMOP installation process is launched, which 
involves a series of different tasks: downloading settings, installing protection, 
updating signature files, etc.  
 
As a fundamental component in the dialogue between different computers, the 
agent is a key part of the P2P process described below. 
 

3.6.2 Peer to Peer (P2P) function 
In the case of Panda, the P2P feature reduces use of bandwidth for the Internet 
connection, as computers that have already updated a file from the Internet then 
share the update with other connected computers. This prevents saturating 
Internet connections.  
 
The P2P feature is very useful in the deployment of PMOP when it comes to 
downloading the installation program. When one of the computers has downloaded 
the installation program from the Internet, the others are informed by the 
communication agents, which have then started the PMOP installation process. 
Instead of accessing the Internet, they get the installation program directly from 
other computers. Then the protection is installed. 
 
This function is also very useful when updating the protection engine and the 
signature files, and is implemented in the two local processes that need to 
download files from the Internet: WalUpd and WalUpg Activation is carried out in 
the configuration files of these processes.  
 
WALUPD.ini 
[GENERAL] 
UPDATE_FROM_LOCAL_NETWORK=1 
WALUPG.ini 
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[GENERAL] 
UPGRADE_FROM_LOCAL_NETWORK=1 
 
The P2P feature is independent in each of these local processes. 

 

The basis of the functionality of the P2P feature is as follows: 
 
When a computer has updated signature files or any protection (or the agent itself) 
it sends a broadcast with the information about the files that it has to the rest of 
the computers on the network. 
 
With respect to the sending of information in WALUpg, if a restart is necessary after 
installing/updating the protection, if the user chooses to restart later, the 
information on the P2P feature will be sent immediately instead of waiting for the 
restart. 
 
This function is detailed in the following diagram: 
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The computers save the information and use it when they need it. 
 
If a computer needs any file, it will first check whether another computer has it 
before downloading it from the Internet. If so, it will request the file from the other 
computer. The file is received asynchronously and there is a maximum time that 
must elapse before retrying. 
 
The computer with the file receives a request for the file and sends the message 
containing the file in response. 
 
The computer that requested the file receives it and can continue with the update 
or upgrade. 

For computers to send files to others through the P2P function they must have at least 128 MB RAM. 

3.6.3 Proxy function 
The agent saves a list with information about computers on the network with 
agents and which can send messages to the Internet. These agents are called 
proxies. 
 

 To act as a proxy for other agents, the computer must meet the following requirements: 

- Direct connection to the Internet  

- Have at least 128 MB of RAM. 

When the list of proxies is empty or none of the agents in the list respond 
(availability = 0), the agent sends a message via broadcast to the subnet asking 
“Who is Proxy? so that it can send a message to the Internet via a proxy. 
 
This sequence is demonstrated in the following diagram: 
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When it is waiting for data from the list of valid proxies, the proxy module will not 
attend other requests. 
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The list of proxies has a value associated to each proxy with a maximum number of 
attempts to connect with another agent before it will be considered invalid. By 
default the number is three, and when this value reaches zero the agent will be 
considered invalid as a proxy. If at any time all the proxies in the list are invalid, 
the list itself will be considered invalid and the search for proxies is launched 
through the message “Who is proxy?" 
 
It is possible that the message is sent correctly to the proxy in the list, but the 
proxy discovers it does not have an Internet connection. In this case, the remote 
agent will repeat the sequence described here, resending the message to a proxy in 
the list, but it will also send via TCP a message to the agent that sent the message 
saying “I am not Proxy”, to indicate that it should be removed from the list as it 
does not have a connection to the Internet. 
 
This process is repeated until the message is sent correctly to the Internet or it 
passes through a maximum number of proxies without managing to be sent, in 
which case the message is lost.  
 
You can configure the maximum number of proxies through which a message can 
pass. By default it will only be sent to one and if the attempt fails the message is 
lost. 
 
The message saves a list of the proxies through which it has passed, to avoid being 
sent twice to the same proxy without Internet connection.  
 

3.6.4 Installation times  
Below we list the different times required for installing the various components of 
PMOP in a computer to administrate, taking into account bandwidth available for 
the Internet (direct installation) and local network (installation using the local 
network). 
 

Direct installation 

Test environment 
The performance tests were carried out in the following test environment.  
 

 
 
The tests emulated the following bandwidth conditions using software allowing a 
reduction in available bandwidth: 
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Size of all downloaded items 
The following items were downloaded from the Internet: 
 
Protection installer: 18 MB 
Signature file: 18 MB. 
 

Test plan 
The study emulated the different bandwidth availability scenarios using specific 
software, and for each computer and bandwidth parameter, the agent was installed 
with direct connection to the Internet. The installation tests included the installation 
of antivirus (AV) and firewall (FW) protection. 
 

Results 
The results obtained are displayed in the following table: 
 
Legend: 
 
- AV installation:  
Installation time of antivirus and firewall protection. 
 
- AV+SIG installation:  
Installation time of antivirus and firewall protection and first complete update of the 
signature file. 
 
- HTTP AV download:  
Time for downloading the protection installer using the browser (Internet Explorer 
6.0) 
 
- HTTP SIG download:  
Time for downloading the signature file using the browser (Internet Explorer 6.0) 
 
 
 
 
 
 
 
 

 
 

 Some tests were not carried out on computer B as they would not have provided 
any additional information to the results on computer A. 
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Installation via local network 

Test environment 
The performance tests were carried out in the following test environment: 
 
 

 
 
The tests emulated the following bandwidth conditions using software allowing a 
reduction in available bandwidth: 
 

 
 

Size of the items transmitted across the network 
The following items were transmitted across the network: 
 
- Protection installer: 18 MB 
- Signature file: 18 MB. 

 

Test plan 
The study emulated the different bandwidth availability scenarios using specific 
software, and for each computer and bandwidth parameter, the agent was installed 
with direct connection to the Internet. The installation tests included the installation 
of the antivirus and firewall protection. 
 

Results 
The results obtained are displayed in the following table: 
 

 
 

 Given that A and B have the same characteristics, only distribution from A to B has been 
tested.  



 
 
 

 
© Panda Security 2008     

47 

Below you will find detailed information about the files, registry keys, local 
processes and services created on installing Panda Endpoint Agent on the 
administered computers. 
 

3.6.5 Deployment of Panda Endpoint Agent  
 

Main architecture modules 
Panda Endpoint Agent comprises the following four main components: 
 
- Administration agent 
- Local processes 
- Watchdog 
- Task scheduler 
 

Panda Endpoint Agent folder tree 
 
In the following diagram, AdminIEClientPath is the root path where the modules are 
installed. 
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WasAgent – Root installation folder of Panda Endpoint Agent. 
Common – Folder with the common files, such as WalAgApi.dll, kernel libraries, etc. 
A sub folder called Data is created in this folder during execution of local processes. 
 
Scheduler – Folder where the task scheduler files will be saved. 
Config - Folder where the task scheduler tokens will be saved. 
WalConf – Folder where the WalConf local process  files will be saved. 
WalTest – Folder where the WalTest local process files will be saved. 
WalLnChr – Folder where the WalLnCh local process files will be saved. 
WalReport – Folder where the WalReport local process files will be saved. 
WalQtine – Folder where the WalQtine local process files will be saved. 
WalScan – Folder where the WalScan local process files will be saved. 
WalUpd – Folder where the WalUpd local process files will be saved. 
WalUpg – Folder where the WalUpg local process files will be saved. 
WalTask – Folder where the WalTask plugin files will be saved. 
WalSysCf – Folder where the WalSysCf plugin files will be saved. 
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WasLpMng – Folder where the local process manager files will be saved. 
Config – Folder where the local process manager tokens will be saved. 
WalSysUd – Folder where the WalSysUd plugin files will be saved. 
WalSysIn – Folder where the WalSysIn plugin files will be saved. 
WAPWInst – Folder where the files of the installation supervision process will be 
saved. 
 
A sub folder called Temp is created under AdminIEClientPath during execution of 
local processes. 
 
WalAgent – Installation root directory of the administration agent. When run, the 
agent creates a subfolder called Data. 
WasWD – Installation root directory of the Watchdog module.  
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Windows registry entries tree 
 

PandaSoftwareRootKey

AdminIE

ClientSystem

InstallPath

SetUpEx

AdminIE

PandaSoftwareRootKey refers to the Windows registry key 
HKEY_LOCAL_MACHINE\SOFTWARE\Panda Security.  
 
AdminIE - Folder where all PMOP registry entries are created. 
ClientSystem – registry key containing the Panda Endpoint Agent entries. These 
entries are: 
InstallPath – This contains the root directly in which Panda Endpoint Agent has 
been installed (“AdminIEClientPath”) 
 
SetupEx - Folder in which the registry entries are created which will be used by the 
Agent installers. 
AdminIE - Registry key containing the Panda Endpoint Agent entries used by the 
installers. These entries are illustrated in the following diagram: 
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When run the agent creates the AgentSystem key under ClientSystem. Within 
this key several entries are created: All the installer has to do is to delete the 
AgentSystem key and its entries in the uninstallation process. 
 

Distribution of files 
All administered computers have the administration agent installed. Along with the 
agent, local processes are also installed. Below we list all the agent paths and files 
of the administration agent and their local processes: 
 

Administration agent  

The agent is installed in <AdminIEClientPath>\WasAgent 
 
- WasAgent.conf  
- WasAgent.exe 
- WaPIRes.exe 
- Wa_AGPRX.dat 
- LPTokens.dat 
- INTEGRA.dat 
- AgentSystem.DAT 
- proxy.dat (generated during installation but not distributed) 
 
During execution of the agent the Data subfolder is created with the following files: 
- WasAgent.log 
- WasLpMng.log 
- WapWinst.log 
- Counters.ini 
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The AgentSystem registry key is also created under ClientSystem. Within this 
key several entries are created: 
 
- Value1 
- Value2 
- Value3 
 
If the Internet connection is via Proxy, the connection details requested from the 
user are stored in AgentSystem.dat in the folder 
<AdminIEClientPath>\WasAgent. 
 
All must be deleted during uninstallation. 
 

WalConf local process 
Installed in < AdminIEClientPath >\WalConf 
 
- WalConf.ini 
- WalConf.dll 
 
 
The following file is created during execution of this local process: 
Walconf.log 
 

WalLnChr local process 
Installed in < AdminIEClientPath >\WalLnChr 
 
WalLnChr.dll 
 
 
The following file is created during execution of this local process: 
WalLnchr.log 
 

WalQtine local process 
Installed in < AdminIEClientPath >\WalQtine 
 
- WalQtine.ini 
- WalQtine.dll 
 
The following file is created during execution of this local process: 
WalQtine.log 
 

WalReport local process 
Installed in < AdminIEClientPath >\WalReport 
 
- WalReport.dll 
- WalReport.ini 
 
The following file is created during execution of this local process: 
WalReport.log 
 



 
 
 

 
© Panda Security 2008     

53 

WalScan local process 
Installed in < AdminIEClientPath >\WalScan 
 
- WalScan.dll 
- WalScan.ini 
 
The following file is created during execution of this local process: 
WalScan.log 
 

WalTest local process 
Installed in < AdminIEClientPath >\WalTest 
 
- WalTest.dll 
- WalTest.ini 
Libxml2.dll – This library only needs to be in this directory if it is not already in a 
directory that appears in the environment variable “PATH”. For example if 
Common is already in PATH, it is not necessary that libxml2.dll is in the WalTest 
directory. 
 
The following files are created during execution of this local process:WalTest.dat 
WalTest.log 
 

WalUpd local process 
Installed in < AdminIEClientPath >\WalUPdWalUpd.dll 
 
- WalUpd.ini 
- Counters.ini 
- WalUpd.log (generated when run) 
Libxml2.dll – This library only needs to be in this directory if it is not already in a 
directory that appears in the environment variable “PATH”. For example if 
Common is already in PATH, it is not necessary that libxml2.dll is in the WalUpd 
directory. 
 
The following files are created during execution of this local process: 
- Counters.ini 
- WalUpd.log  
 
The subfolder Data is created and contains the Catalog subdirectory which can 
have the following files: 
 
- WEB_GUID 
- WEB_CATALOG 
- LAST_GUID 
- LAST_CATALOG 
- LOCAL_CATALOG 
- RUMOR_TABLE 
- LOCAL_CATALOG.TMP  
 
and the Files subdirectory is created which temporarily holds the files needed 
forupdates. 
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WalUpg local process 
Installed in < AdminIEClientPath >\WalUPg 
 
- WalUpg.dll 
- WalUpg.ini 
- PavGenUn.exe 
Libxml2.dll – This library only needs to be in this directory if it is not already in a 
directory that appears in the environment variable “PATH”. For example if 
Common is already in PATH, it is not necessary that libxml2.dll is in the WalUpg 
directory. 
 
The following files are created during execution of this local process: 
 
- Counters.ini 
- WalUpg.log  
- WAUPGTD.dat 
- WAC_Installer.log 
 
The subfolder Data is created and contains the Catalog subdirectory which can 
have the following files: 
 
- WEB_GUID 
- WEB_CATALOG 
- LAST_GUID 
- LAST_CATALOG 
- LOCAL_CATALOG 
- RUMOR_TABLE 
- LOCAL_CATALOG.TMP 
 
and the Files subdirectory is created which temporarily holds the installers needed 
for product installations/updates. 
 

WalTask plugin 
Installed in < AdminIEClientPath >\WalTask 
 
- WalTask.dll 
- WalTask.ini 
Libxml2.dll – This library only needs to be in this directory if it is not already in a 
directory that appears in the environment variable “PATH”. For example if 
Common is already in PATH, it is not necessary that libxml2.dll is in the WalTask 
directory. 
 
The following files are created during execution of this local process: 
- WalTask.log  
SCAN_TASKS.DAT 
 

WalSysCf plugin 
Installed in < AdminIEClientPath >\WalSysCf 
 
- WalSysCf.dll 
- WalSysCf.dat 
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Libxml2.dll – This library only needs to be in this directory if it is not already in a 
directory that appears in the environment variable “PATH”. For example if 
Common is already in PATH, it is not necessary that libxml2.dll is in the 
WalSysCf directory. 
 
The following file is created during execution of this local process: 
- WalSysCf.log  

 

WalSysUd plugin 
Installed in < AdminIEClientPath >\WalSysUd 
 
- WalSysUd\WalSysUd.dll 

 

Local process manager  
Installed in < AdminIEClientPath >\WasLpMng 
 
- WapLpMng.exe 
- WasLpMng.exe 
- Config\Plugins.tok (in the config subdirectory) 
- WapLpmng.ini 
- WasLpmng.ini 
 
The following files are created during the installation process: 
 
- WapLpmng.log 
- WasLpmng.log 

 

Task scheduler 
Installed in < AdminIEClientPath >\Scheduler 
 
- PavAt.exe 
- PavSched.exe 
- PavAt3Api.dll 
- Config\tokens.tok (in the config subdirectory) 
 
The following files are created during execution of this local process: 
 
- Pavsched.cfg (generated during the installation process) 
- Tasklist.lst (generated installation but not distributed) 

 

Watchdog 
Installed in < AdminIEClientPath >\WasWD 
 
- WasWD.exe 
- WasWD.conf 
 
The Data subfolder is created during installation containing the following file: 
WASWD.log 
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All must be deleted during uninstallation. 
 

Common libraries 
Installed in < AdminIEClientPath >\Common 
 
- APIcr.dll 
- avdetect.ini 
- Libxml2.dll 
- MiniCrypto.dll 
- PavInfo.ini 
- pavsddl.dll 
- PSLogSys.dll 
- Pssdet.dll 
- psspa.dll 
- putczip.dll 
- puturar.dll 
- putuzip.dll 
- WalAgApi.dll 
- WalCount.dll 
- WalMnApi.dll 
- WalMnApi.ini 
- WalMnApi.log 
 WalOsInf.dll 
- WalUtils.dll 
- WalUtils.ini 
- WalUtils.log 
 
The Data subfolder is created during execution, which contains the protection 
policies so that they are available when the protection is installed. 
 
The following files are created: 
 
- PavInfo 
- WalUtils.log 
- WALMNAPI.log 

 

Services 
Panda Endpoint Agent uses four services which have to be installed/uninstalled. 
These are: 
 
- PavSched.exe  
This is the task scheduler installed with the agent and that allows you to launch and 
schedule tasks needed for administration. 
 
 
- WasAgent.exe 
This is the service that receives messages from other agents. It is part of the 
administration agent. 
 
- WasLpMng  
This is the local process manager. This loads and calls the corresponding dll 
according to the specified local process token. 
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- WasWD  
This is the Watchdog. This periodically verifies that all services that have been 
specified are executing and if not it launches them again. 
 
The services are installed, calling the executable through the option “-install”, and 
are uninstalled through the option “-remove”. 
 

3.6.6 Deployment of Panda EndPoint Protection (Antivirus + 
Firewall) 

The default installation path is: 
‘%PROGRAMFILES%\Panda Security\WAC\’ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 
 

 
© Panda Security 2008     

58 

Directory structure in the installation path. 
 

InstallPath

Install

psqstore

Restore

Temp

Works

drivers

Firewall

I386

xxxxxxxxxx

X64

Legacy

FileResident

Rpt

Sent

X86

License

 
 
 
 

InstallPath   Panda EndPoint Protection installation path. This contains the files 
needed for Panda EndPoint Protection to operate. 
 

Install   Contains the binaries used when installing / uninstalling the units. 
 

FileResident   Binaries for installing the file resident (not created in systems 
with Windows 2000). 
 
 

drivers   Folder from which the installer gets the binaries to install the file 
resident. 
 

I386   Folder from which the installer gets the binaries to install the file 
resident (only XP x86). 
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X64   Folder from which the installer gets the binaries to install the file 
resident (only x64). 

X86   Folder from which the installer gets the binaries to install the file 
resident (Vista and Server 2008 x86). 
 

Firewall   Folder from which the installer gets the binaries to install the 
firewall. 
 
 

Legacy   Files included for 32-bit compatibility that cannot be included in 
the root folder due to name collision. (only in x64) 
 

License   Directory with the license documents for third-party technology. 
 

psqstore   Quarantine configuration files and items moved to quarantine. 
 

Restore   It contains the items restored from quarantine when they’ve been 
moved by the email protection or when they couldn’t be restored to the original 
path. Each item is restored to a different folder using the name of the quarantine 
identifier. 
 

Rpt   Reports on detections, events, etc. which are sent to the Web 
console. 

Sent   This contains the reports that are being sent to the Web console. 
The reports only appear here during the process of sending them (they are then 
deleted). 
 

Temp   Temporary configuration files created during the scan. 
 

Works   Configuration XMLs of the protection. 
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Registry entries in Panda Software 
 

 
PandaSoftware  Key in “HKEY_LOCAL_MACHINE\Software\Panda Software” in 

which the rest of the Panda product keys and values are located. 
 

Internet  Configuration values for Webproxy technology (responsible for the 
HTTP and POP mail protection). 
 

Panda Antivirus 
Exchange/Outlook  Values needed for the Exchange client mail protection. 

 
Panda Antivirus Lite  Information to use the AV such as, version, installation path, units 

installed, etc. 
 

Panda Network 
Manager   Information to use the Firewall. 

 
Panda Service Host   Values needed for the service responsible for managing the 

firewall. 
Plugins  Incorporates all the plugins loaded at that moment in the service. 

Presently, there are plugins available for Firewall. 
 

Setup   Product information such as, name, version, ID, installation path, 
etc. 
 

Registry entries in Windows\CurrentVersion 
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This section deals with the registry entries ClientShield creates in the 
“HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion” 
key. 
 
 

CurrentVersion

Run

Uninstall

{UID}  
 
 

CurrentVersion  
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion 
 

Run   System key that indicates the path of the applications launched at 
the beginning. 
 
 

 
 
 

Uninstall   System key with information about uninstallers of products 
installed on the system. 
 

{UID}   Key with the information needed to uninstall the product. 
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Registry entries in Services 

 
Registry entries needed for the functioning of the protection drivers and services. 

 
Services   HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services 

 
AmFSM   File permanent protection driver (Windows Vista and x64 

platforms). 
 

APPFLT   Firewall driver 
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DSAFLT   Firewall driver 

 
FNETMON   Firewall driver 

  
IDSFLT   Firewall driver 

 
NETFLTDI   Firewall driver 

 
NETIMFLT*   Firewall driver. The service name is not a fixed value. Varies 

depending on the version. The name is NETIMFLT*, where * is the string of variable 
characters. 
 

Panda Software 
Controller   Panda Software Controller service entries. 

 
PavDrv   File permanent protection driver 

 
PavFnSvr   Entries of the Panda Function Service 

 
PavSrv   Resident file service entries 

 
PsHost   PsHost service entries 

 
PsImSvc   Entries of the Panda IManager Service 

 
PskSvc   Entries of the Panda Kernel Service (only in Windows Vista) 

 
SMSFLT   Firewall driver 

 

Registry entries (other) 
 
 

ExchangeClient

Extensions  
 

ExchangeClient   HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Exchange\Client 
 

Extensions   This key includes the values needed to register the mail resident 
as an extension of the Outlook Exchange client. 
 

Services 

- Panda Antivirus Service 
File resident service responsible for searching the system for malware. 
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- Panda Function Service 
Antivirus management service. 
 

- Panda Host Service 
Service used for managing the firewall. 
 

- Panda IManager Service 
Service for generating warnings and reports concerning the actions of the antivirus 
(detection of malware, updates, installation/ uninstallation of protection units, etc). 
 

- Panda Kernel Service 
Antivirus kernel service. Only in Windows Vista. 
 

- Panda Software Controller 
Antivirus management service. 
 

- Processes 
Apart from the services mentioned above, the following processes can be run on 
the system. 
- Avciman.exe 
Process used by the warnings and reports service (Panda IManager Service) for 
generating warnings on the local computer. 
 

- Avengine.exe 
Process used by resident file for malware detection. 
 

- AvTask.exe 
Process responsible for on-demand scans. 
- Console.exe 
Window for managing the firewall in personal mode. When the status is 
administrative mode, the firewall status is displayed. 
 

- LSPTest.exe 
Diagnoses the LSP layers installed by the antivirus so if they are incorrectly 
installed they will be repaired. 
 

- Panicsh.exe 
Process used for resolving problems in the file resident. 
 

- PFDNNT.exe 
Process used for disinfecting infected files. 
 

- PrRepair.exe 
Tool for restoring the resident in Outlook Exchange mail if it is disabled due to 
errors. 
 

- PsCtrlC.exe 
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It shows the antivirus status in the systray. 
 

- PsImReal.exe 
Generates network warnings and reports to be sent to the PMOP Web console. 
 

- Webproxy.exe 
Mail resident for Outook Express and HTTP resident. 
 
 

3.6.7 Deployment of Panda Endpoint Protection (only Antivirus) 

Deployment of directories 

 
InstallPath

Install

psqstore

Restore

Temp

Works

drivers

I386

xxxxxxxxxx

X64

Legacy

FileResident

Rpt

Sent

X86

License

 
 
 
 

InstallPath   Panda EndPoint Protection installation path. This contains the files 
needed for Panda EndPoint Protection to operate. 
 

Install   Contains the binaries used when installing / uninstalling the units. 
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FileResident   Binaries for installing the file resident (not created in systems 

with Windows 2000). 
 

drivers   Folder from which the installer gets the binaries to install the file 
resident. 
 

I386   Folder from which the installer gets the binaries to install the file 
resident (only XP x86). 

X64   Folder from which the installer gets the binaries to install the file 
resident (only x64). 

X86   Folder from which the installer gets the binaries to install the file 
resident (Vista and Server 2008 x86). 
 

Legacy   Files included for 32-bit compatibility that cannot be included in 
the root folder due to name collision. (only in x64) 
 

License   Directory with the license documents for third-party technology. 
 

psqstore   Quarantine configuration files and items moved to quarantine. 
 

Restore   It contains the items restored from quarantine when they’ve been 
moved by the email protection or when they couldn’t be restored to the original 
path. Each item is restored to a different folder using the name of the quarantine 
identifier. 
 

Rpt   Reports on detections, events, etc. which are sent to the Web 
console. 

Sent   This contains the reports that are being sent to the Web console. 
The reports only appear here during the process of sending them (they are then 
deleted). 
 

Temp   Temporary configuration files created during the scan. 
 

Works   Configuration XMLs of the protection. 
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Registry entries in Panda Software 

 
 

Panda Software

Internet

Panda Antivirus 
Exchange/Outlook

Panda Antivirus Lite

Setup

 
 

PandaSoftware  Key in “HKEY_LOCAL_MACHINE\Software\Panda Software” in 
which the rest of the Panda product keys and values are located. 
 

Internet  Configuration values for Webproxy technology (responsible for the 
HTTP and POP mail protection) 
 

Panda Antivirus 
Exchange/Outlook  Values needed for the Exchange client mail protection. 

 
Panda Antivirus Lite  Information to use the AV such as, version, installation path, units 

installed, etc. 
 

Setup   Product information, such as, name, version, ID, installation path, 
etc. 
 

Registry entries in Windows\CurrentVersion 
This section deals with the registry entries ClientShield creates in the 
“HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion” key. 
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CurrentVersion

Run

Uninstall

{UID}  
 

CurrentVersion  
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion 
 

Run   System key that indicates the path of the applications launched at 
the beginning. 
 

Uninstall   System key with information about uninstallers of products 
installed on the system. 
 

{UID}   Key with the information needed to uninstall the product. 
 
 

Registry entries in Services 

 
In this section we describe the registry entries created for the services and drivers 
of the protection. 
 

 
 
 

Services   HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services 
 

AmFSM   File permanent protection driver (Windows Vista and x64 
platforms). 
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Panda Software 

Controller   Panda Software Controller service entries. 
 

PavDrv   File permanent protection driver 
 

PavSrv   Resident file service entries 
 

PsImSvc   Entries of the Panda IManager Service 
 

PskSvc   Entries of the Panda Kernel Service (only in Windows Vista) 
 

 

Registry entries (other) 
 

ExchangeClient

Extensions  
 
 

ExchangeClient   HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Exchange\Client 
 

Extensions   Values for the registration of the file resident as an Exchange 
client extension. 
 

Services 

- Panda Antivirus Service 
File resident service responsible for searching the system for malware. 

 

- Panda IManager Service 
Service for generating warnings and reports for the user concerning the actions of 
the antivirus (detection of malware, updates, installation/ uninstallation of 
protection units, etc). 
 

- Panda Kernel Service 
Antivirus kernel service. Only in Windows Vista. 
 

- Panda Software Controller 
Antivirus management service. 

 

- Processes 
Apart from the services mentioned above, the following processes can be run on 
the system in an installation of PMOP with only the AV. 
 

- Avciman.exe 
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Process used by the warnings and reports service (Panda IManager Service) for 
generating warnings on the local computer. 
 

- Avengine.exe 
Process used by resident file for malware detection. 
 

- AvTask.exe 
Process responsible for on-demand scans. 
 

- LSPTest.exe 
Diagnoses the LSP layers installed by the antivirus so if they are incorrectly 
installed they will be repaired. 
 

- Panicsh.exe 
Process used for resolving problems in the file resident. 
 

- PFDNNT.exe 
Process used for disinfecting infected files. 
 

- PrRepair.exe 
Tool for restoring the resident in Outlook Exchange mail if it is disabled due to 
errors. 
 

- PsCtrlC.exe 
It shows the antivirus status in the systray. 
 

- PsImReal.exe 
Generates network warnings and reports to be sent to the PMOP Web console. 
 

- Webproxy.exe 
Mail resident for Outook Express and HTTP resident. 
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3.6.8 Deployment of Panda EndPoint Protection (only Firewall) 
 
The default installation path is: 
 
‘%PROGRAMFILES%\Panda Security\WAC\’ 
 
 

InstallPath

Install

Temp

Works

Firewall

Rpt

Sent

License

 
 
 

InstallPath   Panda EndPoint Protection installation path. This contains the files 
needed for Panda EndPoint Protection to operate. 
 

Install   Contains the binaries used when installing/uninstalling the units. 
 

Firewall   Folder from which the installer gets the binaries to install the 
firewall. 
 

License   Directory with the license documents for third-party technology. 
 

Rpt   Reports on detections, events, etc. which are sent to the Web 
console. 

Sent   This contains the reports that are being sent to the Web console. 
The reports only appear here during the process of sending them (they are then 
deleted). 
 

Temp   Temporary configuration files created during the scan. 
 

Works   Configuration XMLs of the protection. 
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Registry entries in Panda Software 
 
 

 
 
 
 

PandaSoftware  Key in “HKEY_LOCAL_MACHINE\Software\Panda Software” in 
which the rest of the Panda product keys and values are located. 
 

Panda Antivirus Lite  Information to use the AV such as, version, installation path, units 
installed, etc. 
 

Panda Network 
Manager   Information to use the Firewall. 

 
Panda Service Host   Values needed for the firewall management service. 

Plugins  Incorporates all the plugins loaded at that moment in the service. 
Presently, there are plugins available for Firewall. 

Setup   Product information, such as, name, version, ID, installation path, 
etc. 
 

Registry entries in Windows\CurrentVersion 

 
This section deals with the registry entries ClientShield creates in the 
“HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion” key. 
 
 

CurrentVersion

Run

Uninstall

{UID}  
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CurrentVersion  
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion 
 

Run   System key that indicates the path of the applications launched at 
the beginning. 
 

Uninstall   System key with information about uninstallers of products 
installed on the system. 
 

{UID}   Key with the information needed to uninstall the product. 

 

Registry entries in Services 

 

 

 
 
 

Services   HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services 
 

APPFLT   Firewall driver 
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DSAFLT   Firewall driver 

 
FNETMON   Firewall driver 

  
IDSFLT   Firewall driver 

 
NETFLTDI   Firewall driver 

 
NETIMFLT*   Firewall driver The service name is not a fixed value. Varies 

depending on the version. The name is NETIMFLT*, where * is the string of variable 
characters. 
 

Panda Software 
Controller   Panda Software Controller service entries. 

 
PavFnSvr   Entries of the Panda Function Service 

 
PsHost   PsHost service entries 

 
PsImSvc   Entries of the Panda IManager Service 

 
SMSFLT   Firewall driver 

 

Registry entries (other) 
 

ExchangeClient

Extensions  
 
 
 

ExchangeClient   HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Exchange\Client 
 

Extensions   This key includes the values needed to register the mail resident 
as an extension of the Outlook Exchange client. 
 

Services 

- Panda Function Service 
Antivirus management service. 
 

- Panda Host Service 
Service that manages the Panda firewall. 
  

- Panda IManager Service 
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Service for generating warnings and reports concerning the actions of the antivirus 
(detection of malware, protection updates, installation/ uninstallation of protection 
units, etc). 
 

- Panda Software Controller 
Antivirus management service. 

- Procesos 
Apart from the services mentioned above, the following processes can be run on 
the system. 
 

- Avciman.exe 
Process used by the warnings and reports service (Panda IManager Service) for 
generating warnings on the local computer. 
 

- AvTask.exe 
Process responsible for on-demand scans. 
- Console.exe 
Window for managing the firewall in personal mode. When the status is 
administrative mode, the firewall status is displayed. 
 

- PsCtrlC.exe 
It shows the antivirus status in the systray. 
 

- PsImReal.exe 
Generates network warnings and reports to be sent to the PMOP Web console. 
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4. Examples: configuration and installation 
recommendations 

 
As mentioned above, this guide details a series of examples for installing and 
configuring the protection.  
 
These examples are based on real experiences; situations that occur in different 
types of companies, with different networks and protection needs. They are only a 
small sample, as every company has its own peculiarities and conditions. Yet they 
represent a starting point from which you can begin to configure the protection of 
your network. 
 
The examples presented here are flexible, they can be combined and you can make 
variations on them. Remember that all configuration and installation choices will be 
strongly conditioned by the quality of internal communications in the company and 
its Internet connection.  
 
Analyze these examples and use the one that is closest to your situation in order to 
make the most of the security performance offered by PMOP.  
 

4.1 Example 1. SMB with a local network of 30 
computers 
Company description  
SMB with a local network of 30 computers (a network administrator and 
workstations).  
 
One characteristic of this company is that Internet access is not generalized, with 
only a few computers connecting to the Web, sometimes only that of the network 
administrator. In this case it is advisable to use the default configuration and 
the quick installation option offered by PMOP.  
 
However, some employees have different requirements from others with respect to 
internal network connections and the Internet. For example, there are two people 
responsible for compiling information about the sector in which the company 
operates. As they must search for information that appears in the press about the 
company's products and those of competitors, they need free access to the 
Internet, while employees in the rest of the departments do not.  
 

Configuration recommendations 
The procedure involves creating the necessary profiles (one open and one 
restricted) and configuring them both. Then create two groups (open and 
restricted) and distribute computers accordingly. Then assign each group 
corresponding profile. 
 
  
1.  Create a new profile. Call it open_ profile for example.  
 

This profile will be the same as the Default profile, modifications to the configuration can be made at 
any time, but it can also be deleted when you want.  
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2.  Create another profile. Call it restricted_profile for example.  
 
3.  Configure this profile. To do this, click Add and in the Edit profile – New 
program rule window click Browse. Go to the location of the Internet browser 
you want to block, select the executable file of the browser and click Open.  
 
4.  Then, in the Communication menu, select the type of communication you 
want to apply to the new rule you are creating (by default No connection, which is 
applied in this case) and click OK.  
 
In the Edit profile window, you will see the name of the browser and the 
communication assigned. 
 
5.  Create the groups of computers you need . In this case, create two 
groups, and call them, for example: open_group and restricted_group.  
 
6.  Assign the corresponding computers to each group, depending on the 
configuration profile (open or restricted) you want to apply. To do this: 
 
7.  Select Group. 
 
8. Click Create new group. 
 
9.  Specify the name of the group and the profile you want to assign. 
 
10.  Select the computers you want to include in the group, and click Assign. 
 

 In the case of the ‘open group’, instead of creating a specific profile, you can also select the Default 
profile, and in the General tab, enable the option to allow administration from the client. 

 If you want to block any other type of access in addition to the Internet, for example P2P applications, 
you can do so from the Programs or System tab Sistema of the profile firewall settings. Remember that 
the rules you configure for specific ports and protocols from the System tab have priority over general 
rules established in Programs.  

With respect to the installation mode  it is advisable to use the installation 
program, or send all computers the email with the installation link. A wizard will 
guide users through the installation process. 
 
Computers can be moved from one group to another once the protection is 
installed. It is also possible to delete a group by clicking on the name and selecting 
Delete from database, in the Computer details screen.  
 

4.2 Example 2. Company with a centralized network 
Company description  
Centralized company, physically located on different floors, with at least 100 
computers grouped into different domains. The company is structured into four 
departments: Accounts, Sales, Stock and Human resources. There is a server in the 
Accounts department, configured for: 
 
- Email  
 -Web service 
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- Shared folders on different network drives. 
 
They want to allow free access to the Internet for people in the Sales department. 
They want to block access to the Internet for people in the Stock department. In 
Accounts and Human resources they want to block the use of a certain instant 
messaging application. 
 

Configuration recommendations 
In this case we recommend the creation of three profiles:  
 
- One for the server in the Accounts department,  
- One with restricted Internet access for the Stock deparment,  
- And another with the IM application blocked for Accounts and Human Resources.  
 
In the case of the Sales department, the option for administering the firewall from 
the client will be enabled (from Endpoint). 
 
Firstly, create a profile for the server (call it for example, server_profile).  

 

1.  General settings 

 
In this case you can disable the option Show local warning on detecting 
malicious software, in the Warnings tab. 
 
It is also a good idea to configure the updates, but remember that as it is a server, 
it is advisable that the update process (and consequent server restart if necessary) 
takes place within a time period that does not prevent normal operation of the 
corporate network.  
 
With this in mind, click Advanced update settings, in the Main tab of the Edit 
profile window. Specify the period of time and whether you want to authorize 
automatic restart of the server if necessary. Then click OK. 
 
Logically, you will now have to configure the anti-malware and firewall protection so 
this profile is adequate for a server of these characteristics.  

 

2.  Anti-malware protection 

 
Files tab: By default the antivirus protection protects all types of files in the 
server. If you want to exclude any type of file from the protection you can use the 
advanced settings for the file protection.  
Heuristic tab: As this is a computer that acts as a server of shared directories on 
network drives, this normally means that many users will be accessing and 
administering files and applications, according to the permissions they have. If 
users only have read permissions there is no problem, but when they also have 
permissions to copy, edit and modify files, the situation changes. The heuristic scan 
analyzes the behavior of files and applications in-depth.  

 

3.  Firewall protection 
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It is important that the configuration of the firewall protection in a server is carried 
out carefully, and that the person responsible is an administrator who knows the 
services for which the server has been configured and the ports that are used. This 
would prevent any modification to the firewall protection settings in the server from 
conflicting with the services it offers to workstations.  
 
With respect to the workstations, in this example, as it is a large company, two 
groups will be created per department. These groups will be assigned the 
previously created profiles. This allows each group to be assigned a type of profile –
open or restricted- and facilitates the administration of the computers, moving 
them from one group to another and installing protection on computers. 
 
4.  Create an open profile for each department (sales_open, accounts_open, 
etc) 
 
5.  Create the profile stock_restricted and use the Programs tab in the firewall 
configuration to block access to the Internet.  
 
To do this, click Add and in the Edit profile – New program rule window, click 
Browse. Go to the location of the Internet browser you want to block, select the 
executable file of the browser and click Open. Then, in the Communication menu, 
select the type of communication you want to apply to the new rule you are 
creating (by default No connection) and click OK. In the Edit profile window, you 
will see the name of the browser and the communication assigned. 
 
6.  Create the profiles accounts_restricted and humanresources_restricted and 
use the Programs tab in the firewall protection configuration to block access to the 
instant messaging application in both profiles.  
 
To do this, click Add and in the Edit profile – New program rule window, click 
Browse. Go to the location of the instant messaging application you want to block, 
select the executable file of the application and click Open. Then, in the 
Communication menu, select the type of communication you want to apply to the 
new rule you are creating (by default No connection) and click OK. In the Edit 
profile window, you will see the name of the application and the communication 
assigned. 
 
7.  Create two groups of computers per department. You could call them 
sales_open, sales_restricted, stock_open, etc. Assign the computers to the 
corresponding groups. To do this: 
 
-Select Group. 
-Click Create new group. 
-Specify the name of the group and the profile you want to assign. 
-Select the computers you want to include in the group, and click Assign. 
 
Although you have created two groups per department, in the case of the Sales 
department there are no groups assigned the sales_restricted profile, although in 
the future there may be. However, all basic configuration options for the different 
departments have been covered, and from here on, the protection administrator 
will decide the groups to create, eliminate, or modify, etc. 
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With respect to installation, the ideal option is to use the PMOP distribution tool 
to deploy the protection. Once the tool is downloaded and installed on the computer 
from which deployment will be carried out, you can select the computers to which 
to distribute the protection on the basis of the domain to which they belong or 
individually, by IP or name.  
 
Computers can be moved from one group to another once the protection is 
installed. It is also possible to delete a group by clicking on the name and selecting 
Delete from database, in the Computer details screen.  
  

 You must make sure you have administrator rights over the domains in which you are going to install 
the protection. This will prevent you from having to verify your identity on each computer. In any event, 
before installing the protection, always check the requirements. 
 
 

4.3 Example 3. Company with decentralized network 
Company description  
In this case the company is similar to the one in the previous example, but with 
certain differences that will condition the process of configuring and installing the 
protection. 
 
The company is decentralized, with IT resources spread across several branches 
and a different amount of computers in each branch. The company is structured 
into four departments: Accounts, Sales, Stock and Human resources. It has 
multiple servers and domains. In the Sales department, users normally work which 
laptops and are often mobile. In some branches, access to the Internet is very 
slow. 
 
They want to block access to the Internet and instant messaging for all 
departments except the managers of Accounts, Human Resources and Stock. 
Everyone in the Sales department will have access to Internet and instant 
messaging. 
 

Configuration recommendations 
 
1.  Create a profile (call it for example, employees_profile), and in the 
Programs tab of the firewall protection configuration, block access to the Internet 
and instant messaging.  
 
To do this, click Add and in the Edit profile – New program rule window, click 
Browse. Go to the location of the Internet browser, select the executable file of the 
browser and click Open. Then, in the Communication menu, select the type of 
communication you want to apply to the new rule you are creating (by default No 
connection) and click OK. In the Edit profile window, you will see the name of 
the browser and the communication assigned. Repeat the process to block access 
to instant messaging applications. 
 
2.  Create a profile without restrictions (managers_profile).  
 
Create another profile (Sales_profile) and apply the option Allow configuration of 
the firewall from the client in the firewall configuration. 
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3.  Create a group (called for example, Employees) and assign all computers 
to it except those of the managers of Accounts, Human Resources and Stock. 
Assign it the employees_profile. 
 
5.  Create another group (called for example, Managers) and include the 
computers of the managers from the departments mentioned above. Assign it the 
managers_profile. 
 
6.  Create a third group called Sales, and include all computers in the Sales 
department. Assign this group the profile Sales_profile. 
 
In this case there are different installation options.  
 
As the company is decentralized the difference in the number of computers 
between each branch could be considerable. In addition, branches may use 
different distribution tools or their own installation applications. Moreover, slow 
Internet connections could cause problems with downloads.  
 
For these reasons, the recommended installation procedure involves: 
 
- Using the distribution tool in the case of centralized branches, where there is 
optimum Internet connection speed and a relatively high number of computers. 
 
- Using the company's own distribution tools. 
 
For the laptop computers in the Sales group, it is advisable to deploy the protection 
using installation via email. 
 
Computers can be moved from one group to another once the protection is 
installed. It is also possible to delete a group by clicking on the name and selecting 
Delete from database, in the Computer details screen.  
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5.  PMOP Administration 

5.1 The management center: The client Web console 
To access the Web console: 
 
1.  Enter the Login email and Password. 
 
2.  Accept the terms and conditions of the License agreement (you will only be 
asked to do so once). 
 
You will then see the main screen of the Web console. From this screen you can 
access the following areas: Status, Computers, Installation  and Settings, 
Quarantine and Reports. 
 
The Exit option lets you close the session. You can also select the language for 
viewing the Web console, using the list next to the active language. 
 
To create new users and assign them access permissions and management 
privileges, click Users. To establish the general console configuration, click 
Preferences. 

5.2 Preferences 
From this window you have control over a number of general settings regarding the 
Web Console: 
 

5.2.1 General options  
If you don't want the QuickStart guide window to appear every time you open the 
console, select Don't show again. 
 

5.2.2 Default view 
Here you can establish whether computers are displayed by name or by IP. Enable 
the option you want. 
 

5.2.3 Remote connection for support 
Panda Security offers you the services of its technical support team. If you would 
like to receive remote technical support, select Allow remote access from Panda 
Security for tech support. 
 

5.2.4 Group restrictions 
Select this option to limit the  
number of installations and the groups' expiry dates. 
 

5.2.5 Computer blacklist 
You can draw up a list of computers to which the protection will not be distributed. 
You can always add or remove computers to/from the list. Groups of expired 
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computers and computers whose maximum number of installations allowed has 
been exceeded are also blacklisted. 

5.3 Protection status 
The Status area is divided into two sections: Licenses and Antivirus protection. 

5.3.1 Licenses 
Here you can see the number of PMOP licenses that you have contracted and their 
expiry date. To renew the license click Renew license. For more information about 
license management, go to the License management section. 

5.3.2 Antivirus protection 
In this section there are two panels displaying the antivirus protection status, 
depending on the type and source of the detections. 
 
To see detections over a given period of time, select an option in the Period menu 
and click Apply. 
 
Detections by type displays detections of each type of threat. Detections by 
source tells you the origin of the detection. You will find definitions of the different 
types of threats in the Key concepts  section. 
 
 To expand the images, click on them. You can also print them. 
 
Click View list of detections for more information about detections. 
 

5.3.3 List of detections 
The detection monitoring feature allows you to carry out searches of your network 
to know when your computers have been in danger, what types of threats have 
been detected, and which action was taken against them. 
 
The Search menu lets you filter the information you want to obtain. 
 
Select the type of threat detected or the source of the detection.  You can also 
select All detections. 
 
Click Find. 
 
The search results are presented in five columns. The Computer column shows the 
list of scanned computers, presented either by name or by their IP. If you want to 
change the way they are presented, you can do this from Preferences  > Default 
view. 
 
The Name column indicates the name of the threat, and the Type column provides 
information about the type of threat. Finally, under Action you can see the 
measures taken by PMOP to neutralize or eliminate the attack. The Date shows you 
the time and date that the threat was detected. 
 

As a general rule in the Detection monitoring, window, when you place the cursor on any of the items 
in the search list, a yellow tag will appear with information about the item. 
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Finally, you can get more details about the detection. Click the [+] symbol next to 
the name or IP of any of the computers, and go to the Detection details window, 
which will give you more specific details about the detection. 
 
In some cases, you will be able to access information that Panda Security offers on 
its Web page about certain threats. To do this, click View description. 
 

5.3.4 License management and control 
 

Types of clients 

- Subscriber 
Clients who buy licenses with no expiry date. If you are a subscriber client, you will 
see the following text in the Licenses section in the Status window: “Valid until: 
Permanent". You won't have to worry about your license expiry date. 

- Non-suscriber 
Clients whose licenses have an expiry date. If you are a subscriber client, you will 
see the following text in the Licenses section in the Status window: “Valid until: 
00/00/0000 ". 

License management 
You have a series of PMOP licenses. Depending on your needs, you can install the 
protection on computers, uninstall it, remove computers from the list of protected 
computers, add computers to that list, etc. As you use your licenses, the number of 
available licenses will decrease. 

Updating the number of licenses 

 
If you: Then: 
Install the protection on a computer A license will be subtracted from the 

total number of available licenses. 
Remove a computer from the list of 
protected computers 

A license will be added to the total 
number of available licenses 

X licenses will be substracted from 
the total number of available licenses 

X computers will be blacklisted (the 
last computers on which the 
protection was installed) 

 

 

 

Warning regarding contracted licenses 
These warnings use a color system to inform about the percentage of licenses used. 
 
 
If the color of the number of 
licenses used is: 

It indicates: 

orange 85% of the contracted licenses have 
been used 

red All licenses contracted have been 
used 
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 When the number of licenses used exceeds the number of licenses contracted, you can contract more 
licenses from your usual license vendor. PMOP will display a reminder in the Status window. 

If you tried to install the protection on a new computer and there were no available 
licenses left, the computer would be blacklisted. 
 

License expiry date warning 
This warning alerts users when their licenses are about to expire. The same color 
code as in the previous case is used. 
 
 
If the color of the license expiry date 
is: 

It indicates: 

orange There are 30 days or less before 
license expiry 

red The licenses have expired 
 
 

 In both cases you can renew the license by contacting your usual reseller or sales advisor. PMOP will 
display a reminder in the Status window. When the 30-day period is over, you will have an additional 15-
day grace period to renew the licenses. After this, you will not be able to renew them. 

Blacklist 
A computer can be entered in the blacklist manually or automatically. A computer is 
entered automatically in the blacklist when there is an attempt to install the 
protection but the number of installations allowed has been exceeded, or when the 
license have expired. 
 
Blacklisted computers don't update. Also, they are not taken into account in the 
statistics, reports and scans carried out by PMOP. However, the computer license 
will not be added to the total number of licenses used, but will be substracted from 
it. 
 

 A computer can only be removed from the blacklist when there are licenses available and it has been 
blacklisted manually. 

5.3.5 Monitoring of computers 
The Computers area lets you know the status of the protection installed on 
computers on your network. To do this: 
 
In My organization, select the group for which you want to view the protection 
status. 
In the Search menu, select the computers you want to see in accordance with their 
protection status. 
 
Click Find. 
 
The search results are presented in five columns. The Computer column shows the 
list of scanned computers, presented either by name or by their IP. If you want to 
change the way they are presented, you can do this from Preferences  > Default 
view. 
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The Protection update, Signature update, and Protection columns use a series 
of icons to indicate the update status of the protection and their general situation. 

You can access the list of icons by placing the cursor on the option   Key. In 
Last connection you can see the exact date and time at which the computer last 
connected to the update server. 
 

If you place the cursor over a computer's name, a yellow tag will be displayed with information about the 
computer's IP address, the group the computer belongs to and the operating system installed. 

If you want to access protection details about a specific computer, click on the 
computer. You will then see the Computer details window. To add the computer 
to the blacklist, click Add to blacklist. 
 
To remove it from the database, click Delete from the database. This option is 
useful if a computer no longer exists on the network and you want to remove it 
from the database. 
 

5.4 Creating and managing users 
If the default option offered by PMOP does not adapt to the protection needs of 
your network, you can create new users and assign different types of permissions, 
depending on what you want each user to manage.  
 
In the main screen of the Web console, click Users. 
 
The Users window distributes information in three columns: Name, Permissions 
and Status. As you create users, these appear in the list, along with the type of 
permissions that you have given them and their status (enabled or disabled). 
 
You may need to create new user groups and assign them different permissions for 
management and control of groups. PMOP makes this very easy for you. 
 

 The default user displayed by PMOP cannot be removed, and only they email and comments can be 
modified. The application displays it in the list as a name (default user). 

Click Create new user to access the Users - Edition window. Fill out the User name, 
Email, Password and Repeat password fields. 
 
You can add information in the Comments section. 
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5.5 Types of permissions 
In the Permissions menu, select the type of permission to assign to the user: 
 
Type of permission: The user can: 

Total control Manage configuration of all groups. 
Assign computers to groups. 
Move computers from one group to another. 
View all users created on the system. 
Access all clients' Web consoles with total control 
permissions.  

Security administrator Modify their user credentials. 
Create groups and eliminate the groups they 
have permissions over. 
View the clients of groups they have permissions 
on and access the clients' Web consoles with 
security administrator permissons. 

Monitoring Modify their user credentials. 
View and monitor the protection of the groups 
assigned to them. 
View clients of the groups they have permissions 
on. 

 
 
In Groups, select the group or groups on which the user can operate, in 
accordance with the permissions you have assigned them. 
 
Click OK. 
In the main Users - Edition window, check that the user has been created and 
that the name, permission and status appear correctly in the list.  
 
To remove a user, select the corresponding checkbox and click Delete. 
 

5.6 Services 
Click Services, at the bottom of the Web console. From the Services window you 
can send Panda Security suggestions and access the Help area where you will find 
the answers to any doubts that you might have about PMOP, and other information 
and utilities that Panda Security offers you. 
 

5.7 Audits 
Click MalwareRadar Audits if you want to launch a malware audit of your 
network. MalwareRadar is an online, on-demand audit service that detects and 
disinfects malware, especially latest generation malware that can go undetected by 
traditional solutions.  
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6.  Quarantine 
 
PMOP stores in quarantine suspicious or non-disinfectable items, as well as spyware 
and hacking tools detected. 
 
Once suspicious items have been sent to Panda Security for analysis, there are 
three possible scenarios: 
 
Items are determined as malicious, they are disinfected and then restored to their 
original location, provided that a disinfection routine exists for them. 
 
Items are determined as malicious, but there is no disinfection routine, and they 
are eliminated. 
 
It is established that the items in question are not malicious, and they are directly 
restored to their original location.  
 
In the main Web console window, click Quarantine to open the corresponding 
window. It is divided into two sections: a search engine and another section 
displaying the list of results. 
 
In the search area you can filter the items you want to view. There are four filter 
parameters:  
 
Select the type of files to find in the Reason menu. Files are classified according to 
the reason they were put in quarantine. 
 

 

Once you have selected the type of file you want to find, select the group of 
computers you want to search. 
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You can narrow the search more by using Status.  
 
PMOP lets you send Panda Security files and suspicious content for analysis. To do 
this, mark the checkbox corresponding to the item you want to send, and click 
Send to Panda. The file will be analyzed by experts who will send a response 
indicating whether the item contains a threat or not. The Status option indicates 
whether files have been sent, if they are still pending, or if they cannot be sent.  
 
 

 

Select the period you want. 
Click Find.  
 

 

If you want to restore any item, select the corresponding checkbox, click Restore 
and respond affirmatively to the confirmation message. Then, the item will 
disappear from the search list and you can find it in the Exclusions window. To 
access this window, click Exclusions. 
 
If you want to delete any of the items found, select the corresponding checkbox, 
click Delete and respond affirmatively to the confirmation message. 
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If there are several items with the same type of malware, when restoring or deleting one of them, all the 
rest will also be restored or deleted. 

 When you place the cursor on any of the items in the search list, a yellow tag will appear with 
information about the item. 

 The Computer column displays the name of the computer or its IP, depending on what you selected in 
the Default view, in Preferences. 

 

6.1 Exclusions 
When you select an item in the Quarantine window, and choose to restore it, the 
item will disappear from the Quarantine window and will appear in the Exclusions 
window. 
 
As with other windows, here you can also select the number of items to display, 
using the Items per page list.  
 
Just as you can exclude items from quarantine, you can also return them to 
quarantine. To do this, mark the checkbox corresponding to the item you want to 
return, and click Consider dangerous. Then accept the confirmation dialog box. 
The item will disappear from the list of exclusions, and will reappear in the 
quarantine list when it is detected again. 
 

 See the annex Collective Intellegince & Corporate Quarantine to find out more about the 
improvements that Panda Security has applied in its fight against all types of threats.  
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7. Reports 
 
PMOP lets you generate reports about the security status of your network and any 
detections made over a given period of time. You can also select the content that 
appears in the report, whether you want more detailed information and if you want 
graphs. All of these options are quick and simple to manage. 
 
In the main screen of the Web console, click Reports. You will then see the 
Reports window. This window is divided into two sections, one with a results filter 
and another for viewing results. 
 
 

 
 

7.1 Types of reports 
Type of report Information included 
Executive Status of the protection installed and items detected 

over the last 24 hours. Also includes Top 10 lists of 
computers with malware detected  and  attacks blocked, 
respectively. 

Status Gives an overview of the protection status and update 
level at the time of report generation. 

Detections Evolution of detections over the last 7 days. It gives 
information about the computer, group, type of 
detection, action and date when the detection took 
place. 
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Select a type of report and click Generate report. 
 

7.2 Report display 
When the report has been generated, it will be displayed on the right-hand side of 
the window. You have a series of controls to move around the pages, as well as 
carrying out searches and modifying the width of the page. 
 
To export the report, select the format from the list and click Export. 
 

 To export reports in Internet Explorer make sure the Don’t save encrypted pages to disk in the 
Security section of the Advanced tab (Tools> Internet options). 
 

Click   to refresh the report view. 

Click   to print the report. 
 

 The first time you want to print a report (only available in Internet Explorer) you will be asked to install 
an ActiveX control from the SQLServer. 
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8. Uninstallation 
 
Uninstallation of the PMOP protection can be carried out locally through the 
Add/remove programs option in the control panel or using the distribution tool. 
   

8.1 Uninstallation from add/remove programs 
The protection is uninstalled from each computer where it was installed, using the 
Add or Remove Programs option, in the Control Panel (Start> Settings> 
Control Panel). 
 

8.2 Uninstalling with the the distribution tool 

8.2.1 Uninstallation by domains 
Specify the group containing the computers from which you want to uninstall the 
protection.  
 
In the tree, find the computers from which you want to uninstall the protection, and 
enable the corresponding checkboxes. 
 

 

You can also enter a user name and password with administrator privileges on the 
selected computers. It is advisable to use a domain administrator password. In this 
way you won't have to specify the user name and password of every computer. 
 
If you want items removed from quarantine during the uninstallation process, and 
for the computers to be restarted after uninstallation, enable the corresponding 
checkboxes. 
 

8.2.2 Uninstallation by IP or computer name 
Indicate the group of computers (optional). 
 
Select the computers from which you want to uninstall the protection. You can 
indicate the computers' names, IP addresses or IP address range, separating this 
data with commas.  
 
Click Add to add them to the list, or Delete to remove them. 
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You can also enter a user name and password with administrator privileges on the 
selected computers. It is advisable to use a domain administrator password. In this 
way you won't have to specify the user name and password of every computer. 
 
If you want items removed from quarantine during the uninstallation process, and 
for the computers to be restarted after uninstallation, enable the corresponding 
checkboxes. 
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9.  Troubleshooting 

9.1 Error 2081 occurs on installing PMOP 
Cause 
This error is due to a failure in the protection installation process. In short, the 
agent has already been installed and the installation of the protection .msi fails due 
to one of the following reasons: 
 
1.  The installer has been corrupted by the firewall (by GateDefender or a 
similar protection that can eliminate a file in the .msi). 
 
2.  Error in outdated versions GateDefender or the Sonicwall firewall, when it 
communicates via IPsec with the Internet connection router. 
 
3.  The agent does not end the installation correctly and the .msi is launched. 
An error is returned on launching a second .msi. 
 
4. Problems on the PC: other installers, viruses, spyware… 
 
 

Solution  
1.  Check if there is a firewall on the network, and make sure it has not blocked 
the total or partial download of the protection .msi installer. 
The installer’s name is similar to: “XXXXX_Panda Endpoint Protection x86.msi” 
 
By default, once the installer is downloaded, it is left on the following path:  
 
%ProgramFiles%\Panda Security\WaAgent\WalUpg\Data\Files 
 

 To make sure the file downloaded is not corrupt, try the installer on another network PC. It does not 
matter if MOP is already installed. If so, a message will be displayed indicating it. 

 

2.  If there has been a problem on the PC, analyze the walupg.log file. There 
must be another error number (apart from error 2081) on a previous line. 
 
This error number is returned by default on installing a Microsoft .msi package. 
Further information on these error codes is available on the following Microsoft 
links: 
 
 
 
http://msdn.microsoft.com/en-us/library/aa372835.aspx 
 
http://msdn.microsoft.com/en-us/library/aa368542(VS.85).aspx 
 
These problems can be due to previous .msi package installation failures. Use the 
Windows Installer Cleanup Utility tool.  
 
3. Click here to download it.  
 

http://msdn.microsoft.com/en-us/library/aa372835.aspx�
http://msdn.microsoft.com/en-us/library/aa368542(VS.85).aspx�
http://support.microsoft.com/kb/290301�


 
 
 

 
© Panda Security 2008     

97 

4.  Install and run the tool on the computer, and uninstall Panda Endpoint 
Protection. 
 
 

 This tool has been designed for Microsoft Office, but it is also valid in this case. 
 
 
5.  Enable the agent logs and the generic .msi installer: 
 
 
Activate the Agent logs 
 
1.  Go to the Panda Managed Office Protection installation path: 
 C:\Program Files\Panda Security\WaAgent\WasAgent by default 
 
2.  Open the file below with a text editor (Notepad or similar): 
WasAgent.conf  
 
3.  Add the following lines (if they are not included in the file): 
 
[Counters] 
Active=TRUE 
 
[LOG] 
Active=TRUE 
LevelLog=2000  
 
4.  Save the changes in the file, and restart the computer. 
 
The log file generated is “WASAgent.log” and the path is “C:\Program Files\Panda 
Security\WaAgent\WasAgent\Data ” 
 
Activate the .msi installer logs 
 
1. Save the RegLoggingInstaller.re_ file to the hard disk, to the Windows 
Desktop for example. 
RegLoggingInstaller.re_ 
 
2.  Change the name from RegLoggingInstaller.re_ to RegLoggingInstaller.reg  
 
3.  Run the RegLoggingInstaller.reg file  
You will see a message asking if you are sure you want to add the information. 
 
4.  Click Yes. 
 
5.  Launch the installer manually again, by double-clicking the file .msi.   
 
The installation log is generated in %windir%\temp or %temp% with a variable 
name, following the “M*.log”.  
 
Look at the date the log was generated in order to collect the right file. 
 

 When downloaded, the installer is installed in: 
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%ProgramFiles%Panda Security\WaAgent\WalUpg\Data\Files 
 
6.  Restart the PC and enable the .msi logs.  To do this: 
 
- Click Start > Run. 
 
- Type cmd, and press Enter. 
 
- In the black window, type; 
 
Msiexec /i 
 
- Without typing anything else, go to My Computer > Hard Disk (usually C:). 
 
- Open the Program Files folder. 
 
- Select Panda Security. 
 
- Go to WaAgent in the Panda Security folder. 
 
- Open the WalUpg folder > Data > Files. 
 
- The Files folder contains an .msi file with a name similar to “48803058_Panda 
Endpoint Protection x86.msi”. Drag and release the file in the black window where 
you have previously written Msiexec / i. 
 
- The following text will be displayed in the black window: 
 
 Msiexec /i "C:\Program Files\Panda 
Security\WaAgent\WALUPG\Data\Files\4896e1e9_Panda EndPoint Protection 
x86.msi" 
 
- Leave a space and add: 
 /l*v C:\2093.txt 
- The final result is: 
 
Msiexec /i "C:\Program Files\Panda 
Security\WaAgent\WALUPG\Data\Files\4896e1e9_Panda EndPoint Protection 
x86.msi" /l*v C:\2093.txt 
 
- Create a file called “2093.txt” in the hard disk using this command and 
parameters. 
 
- Send the file to Panda Security to fix error 2093 as soon as possible. 
 
7.  If the installation works correctly, disable the agent and .msi logs to avoid 
unnecessary resource usage. 
 
8.  If it does not work, report the incident including the following data: 
 
- Number of computers involved and whether the installation has been correctly 
carried out on any of the computers. 
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- Description of the network. 
 
- All the agent logs (walupg, walupd, wasagent …). 
 
- The 2093.txt file generated from the .msi. 
 
- The latest M*.log files in the client’s temporary folder (%temp% or 
%windir%\temp). 
 
 

9.2 Error 2072 occurs on installing PMOP 
 

Cause 
1.  Loss of Internet connection during the installation process.  
 
2.  This can be due to the following: 
 
3.  Too many connection attempts to the Panda Security server. 
4.  Interruptions in the client’s connection.  
 

Solution 
If the problem takes place on a single computer, restart it and wait for the 
installation process to be launched again. 
 
1.  If the problem takes place on several computers, restart one of them and 
wait for the protection to be correctly installed.  
 
2.  Restart the other computers and make sure the installation takes place 
without errors. 
 

9.3 Error 5000 occurs on installing PMOP 
The following error might occur while installing PMOP: Error 5000. Consult your 
administrator Although it has been detected in the server connection phase, this 
error can occur in any installation phase. 
 

Cause 
1. Loss of Internet connection or connection to the client’s internal network during 
the installation process. 
 

Solution 
1.  Check the Internet connection is operative. 
 
2.  Check the other computers on the network are detected. 
 
3.  Make sure there is no firewall blocking the network traffic. 
 
4.  Make sure the computer date is correct. 
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5.  Restart the computer. 
 
Once you have restarted the computer, the PMOP installation process will be 
automatically launched again. 
 

9.4 Error 2011 on accessing shared folders after 
installing PMOP 
After installing PMOP, even without the firewall, the following symptoms occur: 
 
Cannot access shared folders from the computer. 
Errors occur in the System section of the event viewer. The errors have Event ID 
2011 and an error in the irpstacksize parameter as illustrated in the following 
image: 

 
Solution 
This problem is known to Microsoft and is resolved by editing the value of the 
IRPstacksize parameter in the Windows registry. Refer to the following article for 
more details on the solution: 
“Antivirus software may cause Event ID 2011” 
http://support.microsoft.com/kb/177078 
 

The Microsoft article only refers to IBM and Norton security programs, although other vendors are 
affected. 

 

http://www.pandasecurity.com/img/sop/faqs/PMOP/50019.JPG?sitepanda=empresas�
http://support.microsoft.com/kb/177078�
http://www.pandasecurity.com/img/sop/faqs/PMOP/50019.JPG?sitepanda=empresas�
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Installing the protection 
1.  Go to Start > Programs > Panda Distribution tool, or to the shortcut on 
the Windows Desktop.  
 
2.  In the tool console, select Install protection. The Protection installation 
window will open, which allows you distribute the protection in two ways: 

 

Distribution by Domain 
1.  Enter the group in which you want to include the computers that will be 
installed. This selection will define the settings policies that will be applied to those 
computers. 
 
2.  In the network tree select the domains or computers on which you want to 
carry out the installation.  
 
3.  Use a user name and password with administrator permissions to carry out 
the installation. The user name must be entered in domain\user name format.  
 
4.  Once the data is entered, click Install to generate the installation jobs. 
 

 

Distribution by IP address or computer name 
1.  Enter the group in which you want to include the computers that will be 
installed. This selection will define the settings policies that will be applied to those 
computers.  
 
2.  Add the names of the computers to be installed or their IP addresses, 
separated by commas.  You can also select IP ranges (use the “-“symbol for 
ranges, e.g. 172.18.15.10 – 172.18.15.50).  
Use a user name and password with administrator permissions to carry out the 
installation. The user name must be entered in domain\user name format.  
 
3.  Click Install to generate the installation jobs. 
 
4.  Check the console to see whether the installation job has been carried out 
successfully. From then on the protection installation will begin, completely 
transparently.  
 
5.  Restart the computer if prompted. 
 
Further information about the PMOP installation is available in the Protection 
installation section. 
 
 

10.10  Can PMOP be installed on a network with Panda 
AdminSecure protection? 
Before installing PMOP on computers with the distributed AdminSecure protection, 
you must disable the Automatic installation option. If not, when the 
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AdminSecure agent detects the PMOP installation, it will uninstall it and will install 
the AdminSecure protection again. 
 
Two things can occur depending on the AdminSecure version: 
 
-If the AdminSecure version is later than AdminSecure 4.02 SP2, PMOP will be 
automatically uninstalled through the uninstaller included in AdminSecure. 
 
-If the AdminSecure version is previous to AdminSecure 4.02 SP2, it cannot be 
automatically uninstalled. Consequently, the AdminSecure protection will be 
installed (even if PMOP is installed), causing undesired effects. 
 
On disabling the Automatic installation option in AdminSecure, you can either 
disable it on all computers or just on those in which PMOP will be installed.  In 
short, you will configure the computers in which AdminSecure will not be 
automatically installed, or, in other words, the computers that will be an exception 
to AdminSecure’s automatic installation rule. 
 
To disable the Automatic installation option in AdminSecure: 
In the AdminSecure console, select Settings > Automatic installation 
Click Configure Exceptions, and use the Add button to select the computers to 
be excluded from the installation process. 
 
 

10.11  How can a computer be included in the 
blacklist?  
It can be done manually or automatically. 
 

Manually 
Use the options in the Preferences window.  

Automatically 
A computer is automatically included in the blacklist when it tries to install an 
expired protection license, or when the maximum installations have been exceeded. 
The computer will not be updated and the information from that computer will be 
taken into account in the reports and statistics obtained by PMOP.  
 
 

10.12 How can a computer be restored from the 
blacklist? 
To restore the computer and take it out of the blacklist, there must be available 
licenses. 
 
If the computer has been manually included in the blacklist, select it and apply the 
Restore option in the Preferences window. 
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10.13  Why are some computers out-of-date after a 
PMOP update? 
Sometimes, after updating the version of Panda Managed Office Protection, 
computers that are not updated appear in the Update protection column of the 
Computers tab. 
 
One possible reason for this situation is that the Automatic updates option for the 
computers’ profile is not enabled. 
 
 

Solution 
1.  Enable the automatic updates for the profile corresponding to the computers 
with this error. To do this, follow the steps below: 
 
2.  Go to the Installation and settings tab.  
 
3.  Select Profiles in the panel on the left. 
 
4.  Click one of the out-of-date computers in the list.  
 
5.  Edit the profile of the out-of-date computers and select the General 
settings.  
 
6.  Make sure the Enable automatic updates checkbox is selected in the 
Automatic updates section.  
 
7.  Then click Advanced update options.  
 
8.  Check that the option Enable automatic updates of the protection engine is 
enabled in the Protection engine update section.  
 
9.  Click OK. 
 
Once the automatic updates are enabled, check that after the update period 
configured in the settings, the protection engine is updated correctly. 
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11. Annex: Collective Intelligence and 
Corporate Quarantine 

11.1 Collective intelligence 
In the last years, there has been an alarming increase in the types of malware and 
their distribution. Consequently, security companies have had to redouble their 
effort to obtain optimum protection levels against all types of threats. 
 
Far from being an exception, Panda Security has taken pioneering initiatives, such 
as Collective Intelligence. 
 
The purpose of this technology is to carry out ten times more detections than up 
until now with ten times less effort by leveraging collective knowledge. 
 
The diagram below shows the way in which Collective Intelligence works: 
 
 
 

 
 
 

 
 
 
This new set of technologies comprise the following main characteristics: 

Collection of data from the community 
So far, the security solutions’ architecture was based on the concept that users’ PCs 
were independent entities, isolated from the rest of computers. Consequently, 
every malware strain detected on a computer would be treated aside from the rest. 
This approach prevented security companies from extending the knowledge about 
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the evolution of each malware type as well as allowing other computers to benefit 
from proactive detection of specific samples. 

 
Thanks to Collective Intelligence, Panda Security has created a network of sensors 
and  
malware sources that extend its view of the current malware situation. This makes 
it possible to detect if a suspicious file is malware or not from the time it appears as 
well as spreading this knowledge across the user community in real time. 

Automatic processing of data 
Up to now, analyzing new malware samples presented several limitations. Firstly, 
samples had to be sent by clients to laboratories for analysis. Secondly, the 
analysis was subject to the availability of a lab technician that studied the sample 
and created a signature to distribute it to the rest of clients. However, these tasks 
were not correlated, and so, when the number of different malware samples started 
to grow out of proportion, malware laboratories became saturated and the time 
that passed between the appearance of a new sample and the reception of the 
signature on clients’ computers started to increase. 

 
This can be solved thanks to the Collective Intelligence infrastructure. On one hand, 
malware is automatically collected, classified and deleted. On the other, the whole 
process is carried out online in a few seconds, providing users the benefits of real 
time knowledge. 

 
One of the technologies developed by Panda Security is the Corporate Quarantine, 
whose objective is to collect suspicious malware files from as many computers as 
possible in the most efficient way. This way, it is possible to provide a quick and 
efficient response to the enormous quantity of different malware detected every 
day. 
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11.2 Corporate quarantine 
How does the Corporate Quarantine work? 
 
The figure below shows the process taking place in a malware-infected computer. 
 
 

 
 

 

Step 1 
The Collective Intelligence agent included in the client computer collects 
information about memory processes and objects and makes queries to the central 
Collective Intelligence servers, which check if the file is suspicious or not. 
 
PandaLabs uses a network of around 4,000,000 sensors to know what type of 
malware is in circulation and create specific signatures to protect a client’s PC.  

 

Step 2 
If the file is found to be suspicious, the protection will mark it as such and send it to 
quarantine until a final verdict is passed on the file status. 

Step 3 
To optimize bandwidth consumption, the protection gets a ‘fingerprint’ of the 
suspicious file and sends it to the client’s central console, which coordinates the 
sending of samples to the Collective Intelligence servers. 
 
If a file cannot be identified, the Collective Intelligence servers notify the console, 
which sends the file together with information about it. 
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Step 4 
The file reaches the Collective Intelligence servers, where it is analyzed in-depth 
through a series of more sensitive technologies (sensitive heuristic analysis, 
signature analysis, emulation, sandboxing, virtualization, white lists, etc).  
 
These servers apply proactive techniques which, not being limited by the resources 
of the users’ PCs (CPU, memory limitations…), can classify new malware samples 
automatically in a matter of minutes. 

Step 5 
Once the file has been analyzed by our Collective Intelligence servers, two possible 
responses are returned, with different actions for each of them: 
 
The file is Malware  
Information about the type is provided (worm, Trojan…). 
Also, the protection treats the item according to the data received and the policies 
established by the administrator.  
The file is Goodware  
The item is restored as it is known and it is not dangerous. 
 

Conclusion 
The last few years have witnessed a change in the way cyber-crooks think and act, 
exposing a series of flaws in the security industry. 
 
Firstly, malware creators have found a way to make a profit out of malware 
creation, which has brought about a change in their motivation. Now they launch 
targeted attacks much more effective than old massive attacks that affected 
thousands of computers. This has saturated security laboratories, which cannot 
cope with the huge number of malware samples that they receive every day. 
Malware samples cannot be analyzed manually like in the past. 
 
Finally, there is false sense of security as massive attacks have been replaced with 
targeted attacks designed to go unnoticed by the general public and anti-malware 
programs. 
 
 
There are so many new malware samples in circulation that the time that passes 
between an attack on a user’s computer and the analysis of the sample at the lab is 
used by hackers to infect other PCs without the users knowing.  
 
Thanks to the corporate quarantine, part of the new Collective Intelligence, Panda 
can reduce the time during which users are left unprotected. Panda detects new 
malware from the time it appears, transmitting the knowledge to all our clients in 
real time and protecting them against new threats. 
  


